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Version 2.2.3 Updates

Sterling File Gateway 2.2.3 provides enhanced functionality.

The following enhancements are available in Sterling File Gateway 2.2.3:

Quick Start Guide
The information you need to get started with IBM® Sterling File Gateway version
2.2.3 is provided in this guide.

About Sterling File Gateway

Sterling File Gateway utilizes the Sterling B2B foundation, which includes IBM
Sterling B2B Integrator, Sterling Standards, and the Sterling platform, to deliver
capabilities similar to those found in Sterling Advanced File Transfer and IBM
Sterling Connect:Enterprise® for UNIX, while adding new features and
functionality.

Use Sterling File Gateway for movement of large and high-volume file transfers,
with end-to-end visibility of file movement in a process-oriented and
highly-scalable framework that alleviates file transfer challenges, such as protocol
and file brokering, automation, and data security.

Sterling File Gateway supports integration with Sterling B2B Integrator Mailbox,
IBM Sterling Control Center, IBM Sterling Secure Proxy, IBM Sterling
Connect:Direct® for UNIX server products, Sterling Connect:Direct for Microsoft
Windows, and IBM WebSphere® MQ File Transfer Edition. Sterling File Gateway,
which is delivered atop the Sterling B2B Integrator platform with a unique
application URL, provides single sign-on access to the Sterling B2B Integrator
administrative console through menu selection.

System Requirements

Sterling File Gateway system requirements are contained in the Sterling B2B
Integrator System Requirements

What's new in release 2.2.3
There are several new features and enhancements in release 2.2.3.

Integration with WebSphere MQ File Transfer Edition

The Sterling File Gateway 2.2.3 release provides integration with IBM WebSphere
MQ File Transfer Edition. The key elements of the integration are:
v Support for inbound file transfer requests from WebSphere MQ File Transfer

Edition to Sterling File Gateway
v Support for outbound file transfer requests from Sterling File Gateway to

WebSphere MQ File Transfer Edition
v Management of WebSphere MQ File Transfer Edition file transfer activity
v Asynchronous file delivery with delivery updates
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v Response processing for WebSphere MQ File Transfer Edition agents
v Visibility of WebSphere MQ File Transfer Edition in Sterling File Gateway in lists

of protocols, event reporting, logging, and other visibility-related facilities.
v Sterling Control Center monitoring of activity between WebSphere MQ File

Transfer Edition and Sterling File Gateway
v Integration of WebSphere MQ File Transfer Edition with the Sterling B2B

Integrator mailbox subsystem
v A new adapter, WebSphere MQ File Transfer Edition Agent Adapter, that acts as

an embedded WebSphere MQ File Transfer Edition agent within Sterling B2B
Integrator

v A new service, WebSphere MQ File Transfer Edition Create Transfer Service, that
is used to create transfer requests.

Note that important elements of this release are implemented in Sterling B2B
Integrator. Sterling File Gateway provides additional features and functionality on
this base.

Additional Tasks for Resolving Issues and File Status after
System Failure

Tasks for troubleshooting and resolving issues after a system failure and
determining file status after a system failure are included. See Troubleshoot and
Resolve Issues after a System Failure and Determine File Status after a System Failure.

Translation

Sterling B2B Integrator release 2.2.3 supports translation. Translation includes
support for several languages that can be used in the user interface and for
notifications. See Translation for details.

Language for Notifications Sent by email Setting in Profile

Sterling File Gateway users can now modify the language for notifications sent by
email from the Profile > Notifications tab in the Sterling File Gateway user
interface. Users can choose from 9 languages supported for translation or English.
During Sterling File Gateway login, the system checks to determine whether the
Sterling B2B Integrator "Preferred Language " setting for email notifications is the
same as the browser's language setting. If they are not the same, the user is
prompted to change the language setting. See Set the language for notifications for
details.

Creating Custom email Notifications

If email notifications in multiple languages are needed, define the notification
properties in the new filegateway_notifications.properties file and edit the .xlst
templates provided with Sterling File Gateway 2.2.3. See Creating email notifications
in multiple languages for details.

Additional Details for Sterling Connect:Direct Parameters

In the Create a partner wizard, Sterling File Gateway provides the ability for you
to specify certain IBM Sterling Connect:Direct parameters for use in each partner's
profile. The documentation explains these parameters and acceptable values. See
Create a partner in the Route Provisioner help.
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Add Custom Tabs to myFileGateway

The procedure for creating new tabs for additional functionality in myFileGateway
has been modified. Sample assets are now included in the installation. These assets
can be used as the basis to create custom tabs, for example, a custom Welcome Tab.

Multiple Rebranding

Multiple rebranding includes:
v New property in filegateway_ui.properties to support multiple different custom

versions of rebranding. See filegateway_ui.properties.
v Procedure to implement multiple rebranding for myFileGateway. See Rebrand

Sterling File Gateway and myFileGateway.
v Additional information for setting the URLs when implementing multiple

rebranding. See Setting up HTTPS for myFileGateway.

Export and Import with Resource Tags

The export and import process has been modified. If there is a Resource Tag on the
target system with the same name as the Resource Tag on the source system, you
no longer have to rename the target system Resource Tag before you export and
import the source system Resource Tag.

Export and Import Documentation Enhancements

The documentation for using Export and Import to migrate from one version or
patch to another has been expanded in the 2.2 documentation. The expanded
documentation includes guidelines, requirements, and settings for the major steps
in the migration process:
1. Migrating Sterling Integrator Managed Resources
2. Migrating Custom Protocols
3. Migrating a Sterling File Gateway Community
4. Migrating Sterling File Gateway Configurations

Revising Business Process Names for Custom Protocols

There is a restriction for revising business process names for custom protocols. See
Adding custom protocols.

Parameter Changes for Event Codes in the
filegateway_eventcodes.properties and
customer_overrides.properties Files

Event Codes parameters have been modified. See filegateway_eventcodes.properties
and customer_overrides.properties

Overview

About IBM Sterling File Gateway
Sterling File Gateway is an application for transferring files between partners using
different protocols, file naming conventions, and file formats.

Version 2.2.3 Updates 3



Sterling File Gateway utilizes the Sterling B2B foundation, which includes IBM
Sterling B2B Integrator, Sterling Standards, and the Sterling platform, to deliver
capabilities similar to those found in Sterling Advanced File Transfer and IBM
Sterling Connect:Enterprise for UNIX, while adding new features and functionality.

Use Sterling File Gateway for movement of large and high-volume file transfers,
with end-to-end visibility of file movement in a process-oriented and
highly-scalable framework that alleviates file transfer challenges, such as protocol
and file brokering, automation, and data security.

Sterling File Gateway supports integration with Sterling B2B Integrator Mailbox,
IBM Sterling Control Center, IBM Sterling Secure Proxy, IBM Sterling
Connect:Direct for UNIX server products, Sterling Connect:Direct for Microsoft
Windows, and IBM WebSphere MQ File Transfer Edition. Sterling File Gateway,
which is delivered atop the Sterling B2B Integrator platform with a unique
application URL, provides single sign-on access to the Sterling B2B Integrator
administrative console through menu selection.

How Sterling B2B Integrator and Sterling File Gateway Work
Together

Sterling File Gateway utilizes the Sterling B2B foundation, which includes Sterling
B2B Integrator, Sterling Standards, and the Sterling platform, to deliver capabilities
similar to those found in Sterling Advanced File Transfer and Sterling
Connect:Enterprise for UNIX, while adding new features and functionality.

Within Sterling File Gateway, Sterling B2B Integrator is known as the B2B Console,
and is accessed from the Tools menu. Administrative functions such as creating
and managing user accounts, permission groups, and security keys for Sterling File
Gateway are handled in Sterling B2B Integrator.

Sterling File Gateway utilizes the communication adapters of Sterling B2B
Integrator, which include the following:
v FTP Server adapter
v FTP Client adapter
v SFTP Server adapter
v SFTP Client adapter
v HTTP Server adapter
v HTTP Client adapter
v Connect:Direct Server adapter
v Command Line adapter 2 (for PGP)
v WebSphere MQ File Transfer Edition Agent adapter
v WebSphere MQ File Transfer Edition Create Transfer Service

To install Sterling File Gateway, you must first install Sterling B2B Integrator. After
you install Sterling File Gateway on an instance of Sterling B2B Integrator, when
you install upgrades or new builds of Sterling B2B Integrator, Sterling File
Gateway upgrades and builds are automatically installed as part of the installation
script.

Configuration Checklist for System Administrators
Before installing Sterling File Gateway, review this checklist to understand the
overall process.
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The following table provides the process for implementing Sterling File Gateway:

Stage Description

1 Create an architectural design plan.

2 Determine system and hardware requirements.

3 Obtain product training.

4 Install Sterling B2B Integrator.

5 Install Sterling File Gateway.

6 Tune Sterling B2B Integrator.

7 Configure permissions and set up user accounts for administrative users
(Operators, Route Provisioners, and Integration Architects). Delete default
user accounts or change the default passwords for users installed with
Sterling B2B Integrator.

8 Configure services and adapters, based on the protocols you will use:

v HTTP Server adapter

v HTTP Client adapter

v FTP Server adapter

v FTP Client adapter and services

v SFTP Server adapter

v SFTP Client adapter and services

v Connect:Direct Server adapter and services

v Command Line Adapter 2 for PGP

v WebSphere MQ File Transfer Edition Agent adapter

v WebSphere MQ File Transfer Edition Create Transfer Service

9 Set up any certificates and keys that are required.

10 Verify that a routing schedule is enabled.

How Sterling Secure Proxy and Sterling File Gateway Work
Together

Sterling Secure Proxy can be used as a proxy with Sterling File Gateway and other
HTTP applications and supports a single sign-on connection. Single sign-on (SSO)
provides access control that allows a user to log in once to Sterling Secure Proxy,
using the HTTP protocol, and then gain access to Sterling File Gateway without
logging in again. SSO bypasses normal user authentication in Sterling File Gateway
and trusts that Sterling Secure Proxy has authenticated the user.

After you set up the basic single sign-on configuration, trading partners can
communicate in a secure environment that provides authentication. The trading
partner first connects to Sterling Secure Proxy which then connects to Sterling File
Gateway on behalf of the trading partner.

Following is an illustration of the flow of data:
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See Configure a Single Sign-On Configuration between Sterling File Gateway and
Sterling Secure Proxy.

How Sterling Control Center and Sterling File Gateway Work
Together

IBM Sterling Control Center gives you a consolidated view of your entire file
transfer environment—plus the power to respond quickly and efficiently to
exceptions, and changes in your environment.

To use Sterling Control Center with Sterling B2B Integrator servers, including
Sterling File Gateway and WebSphere MQ File Transfer Edition through Sterling
B2B Integrator, set up a Sterling Control Center service in Sterling B2B Integrator.
See the topic called Monitoring Sterling B2B Integrator with Sterling Control Center in
the Sterling B2B Integrator documentation for more information.

System Admin help

Rebrand Sterling File Gateway and myFileGateway
You can rebrand Sterling File Gateway and myFileGateway to use your company's
logo or other special content. To customize the look of Sterling File Gateway and
myFileGateway, you create a skin, reference this new skin, and restart your system.
You can use the same or different skins for Sterling File Gateway and
myFileGateway.

About this task

The following figure shows the location of the portions of the screens you can
rebrand:
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The corresponding file names are:
v Header:

– [skin]/brandingcontent/header.txt
– [skin]/brandingcontent/myFgHeader.txt
– [skin]/load_skin.js
– [skin]/images/FGimages/brandingimages/...

v Top Menu: [skin]/skin_styles.css
v Central Panel:

– [skin]/skin_styles.css
– [skin]/load_skin.js
– [skin]/images/...

v Footer: [skin]/brandingcontent/footer.txt
v Login Footer:[skin]/brandingcontent/loginFooter.txt

Note: If you rebranded Sterling File Gateway in a previous version, you must
make an additional change after you install Build 5201. Add the menuBackground
property to your custom skin .css file as in the following:
/* --- menu background color for main navigation bar;
default is #7896CF --- */
.menuBackground {
background-color: #7896CF;
}

To rebrand Sterling File Gateway:

Procedure
1. Locate files in the following directories for the default skins:

<install_dir>/container/Applications/filegateway/isomorphic/skins/
FileGateway_vXXX

and<install_dir>/container/Applications/myfilegateway/isomorphic/
skins/FileGateway_vXXX where vXXX is the version identifier of the skin.

Tip: To create more than one style of rebranding, create multiple skins with a
separate directory for each skin.
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2. Copy and rename the “FileGateway_vXXX” directory in path:
<install_dir>/container/Applications/filegateway/isomorphic/skins/
FileGateway_vXXX

You can use any valid directory name. Use a version number in your skin
name, such that if you make changes to your skin files, your users' browsers
will automatically fetch new skin files as opposed to using the browser cache.
In the next steps, the renamed directory is referred to as [skin].

3. To customize the header, you can change the following elements:
v Application Title
v Background Image
v Corporate Logo
v Position of the user name
v HeaderALT

4. To change the Application Title:
a. Open the following file: [skin]/brandingcontent/header.txt
b. Change line 11 to refer to your company name (<span

class="ibm-banner-product-name">My Company</span>)
c. Open [skin]/brandingcontent/myFgHeader.txt
d. Change line 11 to refer to your company name (or another name) (<span

class="ibm-banner-product-name">My Company</span>)
5. To change the browser title text, which appears up in the top left-hand side of

the browser (if different from Application Title, mentioned in the graphic,
above) set the variables:
v fgWindowTitle (for Sterling File Gateway)
v myfgWindowTitle (for myFileGateway)

in customer_overrides.properties as
filegateway_ui.fgWindowTitle=xxx

and
filegateway_ui.myfgWindowTitle=xxx

6. To change the Corporate Logo:
a. Create a new Corporate Logo GIF image, which should be 15 pixels high

by 41 pixels wide and named “hdr_logo.gif”
b. Place this GIF in the following directory:[skin]/images/FGimages/

brandingimages/

c. Open the following file: [skin]/brandingcontent/header.txt
d. Change the reference to isomorphic/skins/FileGateway/images/FGimages/

brandingimages/ibm-logo-white.gif to refer to your skin's directory and
logo filename where your corporate logo image is located
(isomorphic/skins/[skin]/images/FGimages/brandingimages/
hdr_logo.gif). You should also change the image alt tag (alt=My
Company).

e. Open [skin]/brandingcontent/myFgHeader.txt

f. Change line 13 to refer to your skin's directory where your corporate logo
image is located (isomorphic/skins/[skin]/images/FGimages/
brandingimages/ hdr_logo.gif). You should also change the image alt tag
(alt=My Company) on the same line.

7. To change the position of the user name:
a. Open the following file:[skin]/load_skin.js
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b. Change the two variables on Lines 21 and 22 to position the name label
where you desire:
v headerUserNameTop (expressed in absolute pixels from the top)
v headerUserNameLeft (expressed as a percentage of page width, from the

left side)
8. To change the Log In page footer:

a. Open the following file: [skin]/brandingcontent/loginFooter.txt
b. Modify the content to refer to your company name.

9. To change the footer for all pages after the Log In page:
a. Open the following file: [skin]/brandingcontent/footer.txt
b. Modify the content to refer to your company name.

The <DIV> within the footer will be modified such that only a background
color is used and not a background image. You can modify the <DIV> if
preferred. The color of the footer background is found in load_skin.js as the
variable "footerBkClr" and has been explained in the page "load_skin.js"
comments.

10. To turn off the "splash page" for Sterling File Gateway or myFileGateway, go to
the directory: [skin]/images/FGimages/brandingimages/lang and locate the
language for the splash page in one or more of these directories:
English:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/en
German:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/de
Spanish:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/es
Italian:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/it
French:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/fr
Korean:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/ko
Japanese:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/ja
Simplified Chinese:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/zh
Traditional Chinese:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/zh_TW
Portuguese Brazil:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/pt_BR

These steps specify how to turn off the splash page for English. You can adapt
these steps for other languages:
a. Open the "en" directory.
b. Copy the file "BACKUP_noSplash_en.gif"
c. If you are turning off the splash page for Sterling File Gateway, rename the

file you copied to "SFGsplash_en.gif", overwriting the existing file. If you
are turning off the splash page for myFileGateway, rename the file you
copied to "myFGsplash_en.gif", overwriting the existing file.

11. To rebrand the splash page for Sterling File Gateway or myFileGateway , go to
the directory: [skin]/images/FGimages/brandingimages/lang and locate the
language for the generic splash page in one or more of these directories:
English:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/en
German:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/de
Spanish:
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isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/es
Italian:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/it
French:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/fr
Korean:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/ko
Japanese:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/ja
Simplified Chinese:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/zh
Traditional Chinese:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/zh_TW
Portuguese Brazil:
isomorphic/skins/MySkin/images/FGimages/brandingimages/lang/pt_BR

These steps specify how to rebrand the splash screen for English. You can
adapt these steps for other languages:
a. Open the "en" directory.
b. Copy the generic splash page from directory: [skin]/images/FGimages/

brandingimages/generic_splash.gif to the "en" directory you opened in
Step a.

c. If you are rebranding the splash page for Sterling File Gateway, rename the
file you copied to "SFGsplash_en.gif", overwriting the existing file. If you
are rebranding the splash page for myFileGateway, rename the file you
copied to "myFGsplash_en.gif", overwriting the existing file.

12. To suppress hover help:
a. Access the file [skin]/load_skin.js
b. Around Line 398, find the section titled "11) Hovers"
c. Within this section, locate the conditional statement "if (isc.Hover) { ..."
d. Modify the property "defaultWidth:200" to a value of 0 (that is,

"defaultWidth:0")
13. To reference the new [skin],

a. create or open customer_overrides.properties in a text editor. Add the
following line:
filegateway_ui.fgSkinName=[skin]

where [skin] is your new skin name for Sterling File Gateway and
filegateway_ui.myfgSkinName=[skin]

where [skin] is your new skin name for myFileGateway. The values for
[skin] can be different for Sterling File Gateway and myFileGateway.

b. The new skin name needs to be updated in [skin]/load_skin.js. To
update the skin name, change approximately line 54 to refer to the
directory name of your new [skin], as shown:
//----------------------------------------
// Specify skin directory
//----------------------------------------
// must be relative to your application file or isomorphicDir
isc.Page.setSkinDir("[ISOMORPHIC]/skins/[new skin]/")

c. If you want to use multi-rebranding, specify
customContextPathDictatesSkinName=true in the
filegateway_ui.properties.in file. The details about this setting are in the
filegateway_ui.properties.in file:
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# If "true", specifies that the "context path" of the URL ("/abc" in "http://host:port/abc/x/y/z") should be used as the
# name of the skin directory ("<install>/container/Applications/*filegateway/isomorphic/skins/abc" to use the example
# above). This property only has any effect if the context path is not "/filegateway" or "/myfilegateway" and matches
# the regular expression "^/[\\p{L}\\d_]+$".
#
# Unlike the Noapp server, the HTTP Server Adapter permits an arbitrary URI (say "/xyz") to map to the myfilegateway.war
# file (the user would visit "http://host/xyz" instead of "http://host/myfilegateway"). Moreover, multiple URIs can be
# configured on the same HTTP Server Adapter, each pointing to the myfilegateway.war file. In such cases, setting this
# property to true will allow separate skins (themes) to be served out from the same HTTP Server Adapter, based upon the
# URL that the user visits.
#
# This setting does not obsolete the fgSkinName and myfgSkinName properties; regardless of the
# customContextPathDictatesSkinName value, users who visit "http://host/filegateway" or "http://host/myfilegateway" will
# see the skin specified through fgSkinName and myfgSkinName respectively. It is only when the URL deviates from these
# standard names that the customContextPathDictatesSkinName property is examined.

d. Copy this [skin] directory into the myFileGateway directory at:
<install_dir>/container/Applications/myfilegateway/isomorphic/
skins/.

14. To change the header only for myFileGateway:
v Modify only the two files, "header.txt" and "myFgHeader.txt" in the new

directory at:(<install_dir>/container/Applications/myfilegateway/
isomorphic/skins/[skin]/brandingcontent

15. Run the following scripts:
v <install_dir>/bin/hardstop.sh

v <install_dir >/bin/deployer.sh

v <install_dir >/bin/setupfiles.sh (UNIX) or setupfiles.cmd (Microsoft
Windows).

v <install_dir >/bin/run.sh
16. If any branding files modified contain a matching .gz file (for example,

"load_skin.js" and "load_skin.js.gz"), then the .gz file must be removed. Check
the /install/noapp/deploy/myfilegateway/webapp or /install/noapp/deploy/
filegateway/webapp directory to ensure your changes have been propagated
as expected.

17. Refresh your browser cache.

Results

When you launch Sterling File Gateway, the new branding is shown in the header
and footer. When your Partner users launch myFileGateway, the new branding is
shown in the header.

Setting up HTTPS for myFileGateway
About this task

To run myFileGateway inside your secure network, no configuration is required.
An HTTP Server adapter configuration (named Http Server Adapter) comes with
Sterling File Gateway that enables the clients on the same network as Sterling File
Gateway to access myFileGateway.

To run myFileGateway in a data management zone (DMZ), an HTTP Server adapter
must be configured that uses a remote perimeter server.

After a Perimeter Server has been configured in Sterling B2B Integrator, its name is
available to the HTTP Server adapter configuration, in the Perimeter Server Name
list on the HTTP Connection Properties page.

Restriction: You cannot deploy Sterling File Gateway on an HTTP server adapter.
Only myFileGateway can be installed on an HTTP server adapter.

To configure myFileGateway to run in the DMZ:
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Procedure
1. Set up a perimeter server in the DMZ.
2. Configure a new Perimeter Server in Sterling B2B Integrator. The port specified

in the Perimeter Server configuration must not be the HTTP listen port (to
which trading partners are expected to connect), which is specified in a
subsequent stage.

3. Ensure that the remote perimeter server is running.
4. Create a new instance of the HTTP Server Adapter configuration.

a. Log into Sterling File Gateway as a system administrator.
b. Select Tools > B2B Console.
c. From the Sterling B2B Integrator Admin menu, select Deployment >

Services > Configuration.
d. Under Create, next to New Service, click Go!

e. For Service Type, open the List View, select HTTP Server Adapter and click
Save, then Next.

f. Give the adapter a new unique name and description. If you are using a
clustered environment, from the Environment list, select the node where the
remote perimeter server is to be assigned. Click Next.

g. For the HTTP Listen Port, specify the port that the Partner is expected to
connect to. This port must not be used by a different application on the
computer that the remote perimeter server is installed on. No two HTTP
Server adapter configurations can listen on the same port on the same
remote perimeter server computer. The default port for Sterling File
Gateway is 33, so select a different port number.

h. From the Perimeter Server Name list, select the name of the Perimeter
Server (previously configured) that corresponds to the specific remote
perimeter server to be used. The name is in the format node & name, where
name is what you specified.

i. For Total Business Process queue depth threshold, enter a number of
business processes to allow in queue. The value of this setting has no effect
if Sterling File Gateway is the only application hosted on this HTTP Server
adapter, because Sterling File Gateway does not depend upon the HTTP
Server Adapter to initiate business processes.

j. For Document Storage and User Authentication Required, you can accept
the default or change to match your system. If User Authentication
Required is chosen, the user will have to login twice, once entering their
username and password in a pop up browser dialog and a second time
through the standard myFileGateway login page.

k. For Use SSL, select Must to implement stronger security. Click Next. See
Implementing SSL in the Sterling B2B Integrator 5.2 online library for more
information about settings for the SSL Settings page. Click Next.

l. On the Services Configuration page, click add, type the URI /myfilegateway.
To accomplish multiple different custom versions of myFileGateway, specify
URI names that match their skin names ("/department1", "/department2",
and so forth), all linked to myfilegateway.war.

m. Select War File. Click Next.
n. Enter the War File Path. The myFileGateway War file is located at <install

dir>\SI\container\Applications\myfilegateway.war. (For UNIX, <install
dir>/container/Applications/myfilegateway.war.)

o. Click Save.
p. In the Confirm page, verify that all parameters are as specified.
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q. Ensure the Enable Service for Business Process check box enabled.
r. Click Finish.

5. If you have access to the computer on which the remote perimeter server is
running, log in to that computer and run the following command:
netstat -an | grep <httpListenPort>

where <httpListenPort> is the port previously specified. If a row is found that
reads, LISTEN, the HTTP Server adapter is ready to handle requests from
external clients.

6. Verify that the HTTP Server adapter is listening and that myFileGateway is
configured correctly by pointing an HTTP browser to the following URL:
https://<host>:<httpListenPort>/myfilegateway

where <host> is the IP address or host name of the computer where the remote
perimeter server is running and <httpListenPort> is the port previously
specified. A dialog opens, requesting the user name and password to use with
myFileGateway. If instead the browser encounters an error, verify that
<httpListenPort> is being listened on. If it is listening, verify that some other
application has not reserved this port. To do this, disable the HTTP Server
adapter and verify that this port is not being listened on. If it is, find the
application that has the port bound and shut it down. Alternately, select a
different HTTP Listen Port and try again.

What to do next

If you have many concurrent users, you may find some degradation of
performance. All HTTP server adapters in your Sterling B2B Integrator installation
share the setting for maximum number of threads that they will consume. To
increase the maximum number of threads running at the same time, edit
customer_overrides.properties to modify the following property:
http.numOfmaxThread=X

where X is the number of threads. The default value is 10. If your users experience
slow response when many concurrent connections have been made to the same
port, increase this value to 50. Continue tuning this value until the system response
is acceptable for the number of concurrent connections that must be supported.
Setting this value too high could be detrimental to system stability when too many
concurrent connections are made.

filegateway_ui.properties
The filegateway_ui.properties file contains properties which control the location of
the Help systems for Sterling File Gateway and myFileGateway, as well as several
other user interface settings.

The following table describes properties in the filegateway_ui.properties file:

Remember: Do not edit the filegateway_ui.properties file. Make all changes in the
customer_overrides.properties file. For example, to change the URL for the Help
system, enter the following line into customer_overrides.properties:
filegateway_ui.help.uri=http://CUSTOM

substituting CUSTOM with your preferred URL. See Using Property Files in
theSterling B2B Integrator 5.2 online library.
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Property Description

reportingdirectory Location of the reports templates.

Required. Do not modify or override.

help.uri Specifies the URL for the Help used by Sterling File Gateway. Required. The default
is:

http://help.sterlingcommerce.com/SFG22/index.jsp

This site is hosted by IBM.

myFghelp.uri Specifies the URL for the help used by myFileGateway. Required. The default is:

http://help.sterlingcommerce.com/mySFG22/index.jsp

This site is hosted by IBM.

notification.partner.url Login URL for partner users to access myFileGateway.Required. The default is:

notification.partner.url=http://&HOST_ADDR;:&PORT1;
/myfilegateway

Important: The specified URL will be included in email messages generated to
partner users. If you implement Sterling Secure Proxy, it is imperative that you
change this property to remove the original server details and replace with the
Sterling Secure Proxy-designated URL.

notification.admin.url Login URL for administrative users to access Sterling File Gateway.Required. The
default is:

notification.admin.url=http://<si-host-address>;;:<si-port-number>
/filegateway

Important: The specified URL will be included in email messages generated to
administrative users. If you implement Sterling Secure Proxy, it is imperative that you
override this property to remove the original server host and port and replace with
the URL designated bySterling Secure Proxy.

fgMaxRoutingChannelRecords Limits the total number of routing channel records returned by a search. Required.
Default is 1000. You can change this to fine tune performance by editing the
customer_overrides.properties file.

myFgStoragetype Storage type to use for new documents sent through myFileGateway. Possible values
are:

v default - use the system default

v db - store documents in database

v file - store documents in file system

The default is default.

To change this value, use the customer_overrides.properties file. For example to set it
to database:

filegateway_ui.myFgStoragetype=db

fgMaxActivityRecords Limits the total number of Activity Records that will be returned in activity search.
This can be edited to fine tune performance. The default is:

fgMaxActivityRecords=1000

fgWindowTitle The title of the window that displays in the top browser bar for Sterling File Gateway.
Required. Default is Welcome to Sterling File Gateway.

myfgWindowTitle The title of the window that displays in the top browser bar for myFileGateway.
Default is Welcome to Sterling File Gateway.

fgSkinName_vXXX The file that contains the branding information for Sterling File Gateway, with XXX
being the version number. Required. Default is FileGateway_v001.

myfgSkinName_vXXX The file that contains the branding information for myFileGateway, with XXX being the
version number. Required. Default is myFileGateway_v001.

fgOnboardingDefaultSessionTimeout The default session timeout in minutes for a Partner User created using the Sterling
File GatewaySterling File Gateway onboarding.

The default is:

fgOnboardingDefaultSessionTimeoutInMinutes=15
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Property Description

fgOnboardingDefaultUserGroupId The group partner users are automatically assigned to when they are created as a
result of creating a partner in Sterling File Gateway, migrated from AFT, or the
partner's identity is associated with a File Gateway partner group. Required. Default
is File Gateway Partners Users Group.

FGConsecFailedAttempts Number of consecutive failed login attempts that are allowed before a user is locked
out of the application. Default is 0, which means users are never locked out.

FGLockInterval Length of time, in minutes, that the lock is applied after the number of failed login
attempts is exceeded. Default is 30.

userIdMinLength Minimum number of characters in the user ID. The default is 5. To enable shorter or
require longer User IDs, modify the following property in
customer_overrides.properties:

ui.userIdMinLength=(# of characters)

The value of # of characters must be greater than zero. To implement single sign-on,
this value must match the value set in Sterling B2B Integrator.

myfilegateway.extension_js_file_x The name of the JavaScript that defines a custom functionality for tabs in
myFileGateway. You can list several .js files by incrementing the final x. The value is
in the format:

myfilegateway.
extension_js_file_1=CustomFunc1.js
myfilegateway.
extension_js_file_2=CustomFunc2.js
where CustomFunc = name of the .js file

myfilegateway.extension_tab_resource_ids Contains a comma separated list of resource identifiers that define additional
permissions. When setting permissions for users that access myFileGateway, assign
myfilegateway.extension_tab_resource_ids for a custom tabs. When you create a
custom tab, you can also create a new permission to control whether a user can view
that tab. Only new and custom tab permissions are listed in this property.

Restriction: Users must have permissions to at least one tab, either the standard
upload, download, file activity, or reports tab, or one of the permissions created for a
custom tab.

customContextPathDictatesSkinName Controls whether the skin to use is determined based on the context path portion of
the URL. Valid values are:

v true

v false (default)

If set to false, the skin name will be determined solely using the values of the
fgSkinName and myfgSkinName properties. The skin name appears in the URL to the
rebranded assets.

If set to true, the myfilegateway.war can be deployed on the HTTP Server Adapter to
a context path other than "/myfilegateway" and this context path will be used as the
skin name. If the context path is "/foo" for instance, the skin name will be determined
to be "foo", which must exist as a custom skin following the steps in the section
"Rebrand Sterling File Gateway and myFileGateway".

customer_overrides.properties
You can add custom event codes that are associated with any custom protocols and
business processes you create. The <EventCode>.name property has been modified
and a new property, <Eventcode>.displayName has been added to the file.

The property modifications and additions include:
v <EventCode>.name - This is the name of the event. Required.
v <EventCode>.displayName - This is the long form of the <EventCode>.name of

your event. It will be shown in the subscription UI (Profile > Notifications) if
subscriptions are enabled and in the log.
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About Event Codes
Each activity during the progress of a file transfer generates an event code. These
codes are displayed in the activity details to enable Partners and Operators to see
the progress and navigate to more details. System Administrators can create
custom event codes and modify the permissions for standard event codes.

Some event codes trigger notifications to subscribers. System Administrators can
change the permissions for an event code by using the
customer_overrides.properties file to override values in the
filegateway_eventcodes.properties file. The default subscription settings are
provided in the table below:

Event
Code Name Description

Default Subscription
Settings

FG_0050 MailboxAuthorizationFailure When a user fails to access a mailbox
that is monitored

Operators

FG_0201 BusinessProcessStarting When a business process is started,
with the reason for starting it stored
in context.

Only in activity details.

FG_0202 BusinessProcessSuccess When a business process is
successfully completed, with a link to
the business process.

Only in activity details.

FG_0203 SendMessageBusinessProcessStarted When a business process is
successfully started, with a link to
the business process.

Only in activity details.

FG_0250 BusinessProcessFailure When a business process fails, with a
link to the business process

Operators

FG_0401 FactDiscovery When a fact is discovered by the
route, for example, matching a
pattern on the file name.

Only in activity details.

FG_0404 ProducerFound When a producer and user are
identified based on the arrived file.

Only in activity details.

FG_0407 ConsumerFound When a consumer is identified based
on the route plan.

Only in activity details.

FG_0408 ArrivedFileStarted When a file arrives to be routed Operators, producers,
and consumers

FG_0409 ArrivedFileDeterminingRoutes When an arrived file starts
determining routes.

Only in activity details.

FG_0410 ArrivedFileRouting When an arrived file starts
processing routes.

Only in activity details.

FG_0411 ArrivedFileRouted When an arrived file completes all its
routes

Operators, producers,
and consumers

FG_0412 RouteStarted When a route is started from an
arrived file.

Only in activity details.

FG_0413 RouteDeterminingDeliveries When a route starts determining
deliveries.

Only in activity details.

FG_0414 RouteDelivering When a route starts processing
deliveries.

Only in activity details.

FG_0415 RouteComplete When a route completes all its
deliveries

Operators, producers,
and consumers
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Event
Code Name Description

Default Subscription
Settings

FG_0416 DeliveryStarted When a delivery is started from a
route.

Only in activity details.

FG_0417 DeliveryTransforming When a delivery starts to transform
the consumer file.

Only in activity details.

FG_0418 DeliveryDelivering When a delivery starts delivering the
consumer file to the consumer.

Only in activity details.

FG_0419 DeliveryComplete When a delivery is complete Operators, producers,
and consumers

FG_0420 ArrivedFileReplayed When an arrived file is replayed,
with a link to the replay

Operators, producers,
and consumers

FG_0421 ArrivedFileReplayOf When an arrived file is a replay of an
original arrived file, with a link to
the original file.

Only in activity details.

FG_0422 Redeliver When a redelivery is requested by a
user

Operators, producers,
and consumers

FG_0423 DeliverRedelivering When a delivery starts redelivering
the consumer file to the consumer.

Only in activity details.

FG_0424 ArrivedFileIgnored When an arrived file is ignored due
to a configured pattern for ignoring
files

Operators, producers

FG_0425 ArrivedFileDescription The description of the Arrived File Operators, producers

FG_0426 DeliveryPending When a Delivery is pending. Operators, producers,
and consumers

FG_427 ManualStateChange When a user manually changes the
state of a delivery.

Operators, producers,
and consumers

FG_0450 ProducerMessageNotFound When a producer message is invalid
or cannot be found

Operators, producers

FG_0451 ProducerDocumentNotFound When a producer document is
invalid or cannot be found

Operators, producers

FG_0455 ArrivedFileFailed When an arrived file fails Operators, producers

FG_0456 RouteFailed When a route file fails Operators, producers,
and consumers

FG_0457 DeliveryFailed When a delivery fails Operators, producers,
and consumers

FG_0458 FileGatewayServiceVersionMismatch When a newer version of a system
business process is installed, but is
not the default chosen version.

Operators

FG_0501 ProducerMailboxRouteCandidatesFound When route candidates are found for
an arrived file based on the producer
and the mailbox of the message.

Only in activity details.

FG_0502 RouteCandidatesFound When route plan candidates are
found for an arrived file.

Only in activity details.

FG_0503 RouteCandidate A route plan candidate for an arrived
file.

Only in activity details.

FG_0504 Route When one or more routes are chosen
from the candidates.

Only in activity details.

FG_0505 RoutesFound The number of routes that will be
executed.

Only in activity details.
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Event
Code Name Description

Default Subscription
Settings

FG_0506 Route Candidate Does Not Match When a routing channel template
contains no matching producer file
structure for an arrived file.

Only in activity details.

FG_0550 ZeroRouteCandidatesFound When no route candidates are found
for an arrived file

Operators, producers

FG_0551 ZeroRouteChannelsFound When no route channels are chosen
from the list of candidates for an
arrived file

Operators, producers

FG_0552 InvalidRoute When a route is invalid Operators, producers

FG_0553 InvalidConsumerBroadcastGroup When value of
ConsumerBroadcastGroup does not
contain name of an existing partner
group

Operators, producers

FG_0554 MaxBroadcastGroupSizeExceeded When the number of consumers in
broadcast scenarios is too big

Operators, producers

FG_0601 TransformedMessage When a message is transformed to
the final format for the consumer.

Only in activity details.

FG_0602 ProducerPayloadExtracting When the router begins to extract a
producer payload file.

Only in activity details.

FG_0603 ConsumerPayloadConstructing When the router begins to construct a
consumer payload file for delivery.

Only in activity details.

FG_0604 ConstructedLayer When a single layer in the consumer
payload file gets constructed.

Only in activity details.

FG_0605 ExtractedLayer When a single layer in the producer
payload file gets extracted.

Only in activity details.

FG_0606 LayerOptions When options are passed to a
business process to process a layer.

Only in activity details.

FG_0607 PGPConstructSkipped When the PGP Construct layer is
skipped because the consumer does
not handle PGP and it is optional on
the Routing Channel Template

Operators, consumers

FG_0650 ExtractLayerFailed When extraction of a layer fails Operators, producers

FG_0651 ConstructLayerFailed When construction of a layer fails Operators, consumers

FG_0701 DeliveredMailboxMessage When a message is delivered to a
mailbox (either a consumer mailbox
or a mailbox for sending to a
listening consumer).

Only in activity details.

FG_0702 DeliveredListeningPartnerMessage When the file transfer is complete. Only in activity details.

FG_0703 ChangeDirectory When the supported protocol
changes directory on the listening
consumer's server to transfer the file.

Only in activity details.

FG_0704 ConsumerDestinationMailboxFound When the destination mailbox for the
consumer is discovered.

Only in activity details.

FG_0705 AsyncTransferIdAssigned When an additional transfer
identifier has been associated with a
delivery.

Operators, producers,
and consumers

FG_0706 AsyncTransferSuccessful When an asynchronous transfer has
reported successful completion.

Operators, producers,
and consumers
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Event
Code Name Description

Default Subscription
Settings

FG_0707 AsynTransferRequestAcknowledged When an asynchronous transfer
request has been acknowledged as
received.

Operators, producers,
and consumers

FG_0750 AmbiguousDeliveryRequestStatus When the submission status of an
asynchronous delivery request is in
doubt.

Operators

FG_0751 DeliveryAlreadyInTerminalState When delivery status notification is
received for a delivery already in a
terminal state.

Operators

FG_0752 AsyncTransferFailed When an asynchronous transfer has
reported failure.

Operators, producers,
and consumers

Adding Custom Event Codes
You can add custom events to Sterling File Gateway that are associated with any
custom protocols and business processes you create. You will need a code, a name,
and a description for each event you want to create, as well as permission and
subscription settings.

About this task

To add custom event codes:

Procedure
1. Open or create a file named /<install_dir>/properties/

customer_overrides.properties.
2. Add entries in the customer_overrides.properties file with the appropriate

details about the custom event codes you are creating. Your new event will be a
series of properties describing attributes of the event. See the
filegateway_eventcodes.properties file for examples. Do not edit the
filegateway_eventcodes.properties file. Use the example as a model:
filegateway_eventcodes.CUST_0265.name=
filegateway_eventcodes.CUST_0265.displayName=
filegateway_eventcodes.CUST_0265.attributes=
filegateway_eventcodes.CUST_0265.text=
filegateway_eventcodes.CUST_0265.description=
filegateway_eventcodes.CUST_0265.permissions=

v Event Code: The event code in the example above is CUST_0265. It consists
of keyword underscore 4-digit code. It is used to identify all the attributes
for a particular event code. Required.
– Keyword - any text, optimally 4 characters long, but cannot be FG_ nor

AFT_. In the example, the keyword is CUST.
– 4-digit Code - consists of two 2-digit codes - a category identifier and a

unique identifier. No two events can have the same 4-digit code.
- Category Identifier - The first 2-digit code is a category identifier. You

can use a system-defined category or create your own 2-digit code to
categorize your codes in a way that is convenient for you. In the
example, the category identifier is 02. The following are the
system-defined category codes:

Code Category

00 Producer File Transfer
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Code Category

02 Routing Business Process

04 File Gateway General

05 Route Plan Determination

06 File Transformation

07 Consumer File Transfer

- Unique Identifier - The second 2-digit code is the unique identifier for
the event within the category. 00 to 49 are successful events and 50 to
99 are error events. Error events display in red in Sterling File Gateway.
You cannot exceed 99 event codes in a category. In the example, the
unique identifier is 65.

v <EventCode>.name - This is the name of your event. Required.
v <EventCode>.displayName - This is the long form of the <EventCode>.Name

of your event. It will be shown in the subscription UI (Profile >
Notifications) if subscriptions are enabled, and in the log.

v <EventCode>.attributes - A comma-delimited list of attributes for this event.
While any attribute can be passed into the event, only these attributes will be
stored in the database, will be searchable through the UI, and are usable in
the event text defined below. They are generally indexed with the first one in
the list having an index of 0. The attribute names must be names that can be
passed as an xml element (no special characters, no spaces). This property is
required but the list can be empty.

v <EventCode>.text - This property contains the text that will show up in the
UI when this event is viewed. It can contain text and is generally limited by
the Java™ Format rules (for example, in order to have a single quote, you
must put two of them right next to each other.) You can also use attributes
above by using the notation {#} which will substitute in the UI the value of
the attribute at the index of the #. You do not have to use attributes, the user
in the UI can click on the event and see all the attributes and they will still
be searchable. So you can send in and store more attributes than you might
want to show in the UI. Required.

v <EventCode>.description - This description is shown in the subscription UI
(Profile > Notifications). Required.

v <EventCode>.permissions - This is a comma-delimited list of permissions for
this event. There are three possible values to use: producer, consumer,
subscription. This property is required but it can be empty. Empty means
that only the Operator can see the event, and no one can subscribe for
notifications to the event.
– producer - This event can be seen and subscribed to by the producer for

this route.
– consumer - This event can be seen and subscribed to by the consumer for

this route.
– subscription - This event can be subscribed to. For a producer or

consumer to subscribe to an event, the event must have the corresponding
producer or consumer permission AND the subscription permission. For a
Operator to subscribe to an event, the event requires only to have the
subscription permission.

v EventNotificationEmailSubject - This is the subject line for the email
notifications when events occurs. This applies to all event codes for your
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system. The default value is File Gateway Routing Event E-mail Notification
[Event Code = {0}], where 0 is the four-digit identifier for the event code.

v EventNotificationEmailContentType - This specifies the content type for the
email notification when the event occurs. This applies to all event codes for
your system. Valid values are text/plain and html. The default is text/plain.

Fast path: See the /<install_dir>/properties/filegateway_eventcodes.properties
file as an example for how to structure your event properties. Do not edit the
filegateway_eventcodes.properties file.

3. Save the customer_overrides.properties file and restart Sterling File Gateway for
the new file to take effect.

4. Edit your business process that generates the new event codes to call the
FileGatewayRouteEventService, with the proper parameters, including the new
custom event codes.

5. Add the FileGatewayRouteEventService, with the proper parameters, including
the new custom event code. The following example will fire a hypothetical
event:
<operation>

<participant name=" FileGatewayRouteEventService "/>
<output message="Output">

<assign to="EventCode">CUST_0265</assign>
<assign to="ExceptionLevel">Normal</assign>
<assign to="EventAttributes/Directory"
from="directory/text()" append="true"/>
<assign to="EventAttributes/Comment" >
BP changed directories</assign>
<assign to="." from="*"></assign>

</output>
<input message="Input">

<assign to="." from="*"></assign>
</input>

</operation>

To send attributes to the FileGatewayRouteEventService, use the following
guidelines. These guidelines only apply to the EventAttributes, not to other
parameters of the service:
v The attributes will be sent to the service as a series of assigns. They need to

be a series of assigns in order to support the advanced event attribute
naming of Sterling File Gateway.

v The first assign must have an attribute append=”true”. This will append the
EventAttributes the first time. The remaining assigns cannot have the append
attribute.
– Hardcoded Values. If you want to send a hardcoded attribute value to the

service (for example, IsError=true, when you know it will be true every
time) then use the following assign statement template:
<assign to=”EventAttributes/IsError”
from=”string('true’)” />

– Process Data. If you want to send an attribute that is copied from another
attribute in the service (for example, the results of another service, stored
in the ProcessData at MyService/ResultCode) then use the following
assign statement template:
<assign to=”EventAttributes/MyServiceResultCode”
from=”MyService/ResultCode/text()” />

You can combine those two methods to send both types of attributes into the
service, adding the append to the first one:

Version 2.2.3 Updates 21



<assign to=”EventAttributes/IsError”
from=”string('true’)” append=”true” />

<assign to=”EventAttributes/MyServiceResultCode”
from=”MyService/ResultCode/text()” />

Example Section in customer_overrides.properties File

Remember: Although the example below shows the items displaying on multiple
lines, do not do so in your implementation.
filegateway_eventcodes.CUST_0265.name=Custom Event - File Error
filegateway_eventcodes.CUST_0265.attributes=ConsumerName,MyServiceResultCode,

IDNumber
filegateway_eventcodes.CUST_0265.text=File Error generated during processing:
Result code: {1} reported for File ID {2} received for Consumer {0}
filegateway_eventcodes.CUST_0265.description=Event from Custom BP generated
when error occurs
filegateway_eventcodes.CUST_0265.permissions=producer,consumer,subscription

Adding Custom Protocols
You can add support for custom protocols for listening consumers in addition to
the ones preconfigured in Sterling File Gateway.

About this task

The information you provide in performing this procedure determines the text
displayed in the Partner management wizard. That is, after you perform this
procedure, new choices are available for protocols offered by Sterling File Gateway
when creating a community and when creating a listening consumer in a
community that is configured for the custom protocol.

Procedure
1. Write a business process that implements the custom protocol. The business

process name must be unique for each custom protocol. Do not use an
underscore character (_) in the name of the business process.

Restriction: The configured business process queue is disregarded because the
business process is invoked inline.

2. Use the existing AFTExtensions.xml as a guide to create an
AFTExtensionsCustomer.xml file to describe the protocol. Do not edit the
AFTExtensions.xml file. The AFTExtensions.xml file is located in the following
directory:<install_dir >/container/Applications/aft/WEB-INF/classes/
resources/xml. For the Element "AFTExtensions", the following attribute is
required:
v bp - The business process created in step 1 that implements the custom

protocol

Important: The value for bp cannot be edited after it is set. The application
does not read the AFTExtensionsCustomer.xml file at run time to obtain a new
value. Do not edit the value of the bp attribute. Create a new protocol with a
different name to use a different business process.

3. Save the AFTExtensionsCustomer.xml file to the same directory as
AFTExtensions.xml.

4. Use the existing AFTExtensions.properties file as a guide to create the
AFTExtensionsCustomer.properties file. Do not edit the
AFTExtensions.properties file. The AFTExtensions.properties is located in the
following directory: <install_dir>/container/Applications/aft/WEB-INF/
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classes/resources The user interface elements to describe the protocol are
specified in the htmlType parameter. Valid values are:
v text
v password
v select - When "select" is chosen for htmlType, the UI presents a list whose

contents are derived from an "options" class. An example of an "options"
class list is in the AFTExtensions.xml file (the text starts with "<OPTION
name="SSHRemoteProfiles" class="

5. Copy the AFTExtensionsCustomer.properties file to: <install_dir>/
container/Applications/aft/WEB-INF/classes/resources

6. Reference the business process you created in step 1 in a new AFTExtension
element in the AFTExtensionsCustomer.xml file.

7. Stop Sterling File Gateway.
8. Run <install_dir>/bin/setupfiles.sh.
9. Run <install_dir>/bin/deployer.sh.

10. Start Sterling File Gateway. The additional protocol will be available when
adding and editing communities. After this protocol has been chosen for a
community, it then becomes available when creating and editing partners in
that community.

Preparing Communications Adapters for Use with Sterling File
Gateway

Sterling File Gateway uses the communications adapters in Sterling B2B Integrator
to receive connections from and make connections to Partners for the purpose of
transferring files. These connections can use various Internet protocols, including
FTP, FTPS, SFTP, SCP, Sterling Connect:Direct, HTTP, HTTPS, and WebDAV. Before
using Sterling File Gateway to route files, configure the communications adapters
in Sterling B2B Integrator.

About this task

To configure communications adapters:

Procedure
1. Determine the communication adapters you require.
2. Review the information needed to configure the adapters you require. The

following adapters can be used with Sterling File Gateway:

Protocol Adapter

FTP, FTPS FTP Server adapter

FTP, FTPS FTP Client adapter and services

SSH/SFTP, SSH/SCP SFTP Server adapter

SSH/SFTP SFTP Client adapter and services

Sterling Connect:Direct Connect:Direct Server adapter

PGP Command Line Adapter 2

HTTP, HTTPS, WebDAV (Requires
extensibility. See Add Custom Protocols.)

HTTP Server adapter

HTTP, HTTPS, WebDAV (Requires
extensibility. See Add Custom Protocols.)

HTTP Client adapter and services
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Protocol Adapter

WebSphere MQ File Transfer Edition WebSphere MQ File Transfer Edition Agent
adapter

WebSphere MQ Suite Async adapter

WebSphere MQ File Transfer Edition Create
Transfer service

FTP Server Adapter

3. Gather the information needed for the adapters.
4. From the main menu, select Tools > B2B Console.
5. Select Deployment > Services > Configuration.
6. Select and configure the adapters you require.

Preparing for PDF Format Reports in Double-Byte Character
Set (DBCS) Languages

Reports in PDF format require installing additional iText libraries to support
correct encoding of double-byte character set (DBCS) languages. Otherwise, the
double-byte characters in generated PDF reports may be missing or illegible.
HTML and XLS formats display correctly in Asian languages and do not require
installing the libraries.

About this task

If you are viewing PDF reports that contain Chinese, Japanese, or Korean
(double-byte) characters, and the characters are either blank or are missing
information, do the following steps:

Procedure
1. Add the following files from the iText library to the classpath of Sterling B2B

Integrator:
v iTextAsian.jar
v iTextAsianCmaps.jar

Download the listed files from:
http://sourceforge.net/projects/itextpdf/files/Asian%20Support/Asian%20CMAPS/

2. Add the downloaded jars from step 1 to the classpath of your application. Run
the below commands, where <install_dir> is the install path and
<download_dir> is the path where the files were downloaded in step 1.
<install_dir>/bin/install3rdParty.sh jasperreports 1_2_0 -j
<download_dir_path>/iTextAsian.jar
<install_dir>/bin/install3rdParty.sh jasperreports 1_2_0 -j
<download_dir_path>/iTextAsianCmaps.jar

3. Direct your users to download and install the Adobe Reader Asian font pack
from the Adobe web site.

Creating email Notifications in Multiple Languages
To create custom email notifications in multiple languages, you modify the
filegateway_notifications.properties file to define the notifications. Then you
modify the templates provided with Sterling File Gateway 2.2.3.
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filegateway_notifications.properties File

This is an example of the filegateway_notifications.properties file:
filegateway.email.msg1=You are receiving this notification because you have
subscribed to this event code and you are the {0} on this route.
filegateway.email.msg2=The following File Gateway routing event occurred
filegateway.email.eventDetailHdr=Route Event Details:
filegateway.email.eventCode=Event Code:
filegateway.email.eventMessage=Event Message:
filegateway.email.dataflowId=DataFlowId:
filegateway.email.producer=Producer:
filegateway.email.consumer=Consumer:
filegateway.email.roleProducer=Producer
filegateway.email.roleConsumer=Consumer
filegateway.email.username=Username:
filegateway.email.filename=Filename:
filegateway.email.producerFilename=Producer Filename:
filegateway.email.consumerFilename=Consumer Filename:
filegateway.email.timestamp=Timestamp:
filegateway.email.hyperlinkMsg=Use the link below to sign into your FileGateway

Suite instance:
filegateway.email.myFGHyperlinkMsg=Use the link below to sign into your

myFileGateway Suite instance:
filegateway.email.unavailable=None

Administrators Template

To create email notifications in multiple languages for Administrators, use this
template:
<?xml version="1.0" encoding="UTF-8"?>
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
<xsl:output method="text" indent="yes" encoding="UTF-8" media-type="text/plain;charset=UTF-8;"/>

<xsl:template match="/">
<xsl:apply-templates select="FgRouteEvent"/>
</xsl:template>

<xsl:template match="/FgRouteEvent">
<xsl:value-of select="filegateway.email.msg2"/>
<xsl:text>&#xa;</xsl:text>
<xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.eventDetailHdr"/>
============================================================================== <xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.eventCode"/><xsl:text> </xsl:text><xsl:value-of select="EventCode"/><xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.eventMessage"/><xsl:text> </xsl:text><xsl:value-of select="EventMessage"/><xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.dataflowId"/><xsl:text> </xsl:text><xsl:value-of select="DataFlowId"/><xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.producer"/><xsl:text> </xsl:text><xsl:value-of select="Producer"/><xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.consumer"/><xsl:text> </xsl:text><xsl:value-of select="Consumer"/><xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.username"/><xsl:text> </xsl:text><xsl:value-of select="Username"/><xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.filename"/><xsl:text> </xsl:text><xsl:value-of select="Filename"/><xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.timestamp"/><xsl:text> </xsl:text><xsl:value-of select="Time"/>
============================================================================== <xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.hyperlinkMsg"/><xsl:text>&#xa;</xsl:text>
<xsl:value-of select="TargetURL"/><xsl:text>&#xa;</xsl:text>
</xsl:template>
</xsl:stylesheet>

Partners Template

To create email notifications in multiple languages for Partners, use this template:
<?xml version="1.0" encoding="UTF-8"?>
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
<xsl:output method="text" indent="yes" encoding="UTF-8" media-type="text/plain;charset=UTF-8;"/>

<xsl:template match="/">
<xsl:apply-templates select="FgRouteEvent"/>
</xsl:template>

<xsl:template name="fill-placeholder">
<xsl:param name="placeholder-text"/>
<xsl:param name="replacement-text"/>
<xsl:value-of select="concat(substring-before($placeholder-text, ’{0}’), $replacement-text, substring-after($placeholder-text, ’{0}’))"/>
</xsl:template>

<xsl:template match="/FgRouteEvent">
<xsl:if test=’not( "consumer" = Role )’>
<xsl:call-template name="fill-placeholder">
<xsl:with-param name="placeholder-text" select="filegateway.email.msg1"/>
<xsl:with-param name="replacement-text" select="filegateway.email.roleProducer"/>
</xsl:call-template>
</xsl:if>
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<xsl:if test=’not( "producer" = Role )’>
<xsl:call-template name="fill-placeholder">
<xsl:with-param name="placeholder-text" select="filegateway.email.msg1"/>
<xsl:with-param name="replacement-text" select="filegateway.email.roleConsumer"/>
</xsl:call-template>
</xsl:if>
<xsl:text>&#xa;</xsl:text>
<xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.msg2"/><xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.eventDetailHdr"/>
=============================================================================== <xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.eventCode"/><xsl:text> </xsl:text><xsl:value-of select="EventCode"/><xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.eventMessage"/><xsl:text> </xsl:text><xsl:value-of select="EventMessage"/> <xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.producer"/><xsl:text> </xsl:text><xsl:value-of select="Producer"/><xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.consumer"/><xsl:text> </xsl:text><xsl:value-of select="Consumer"/> <xsl:text>&#xa;</xsl:text>
<xsl:if test=’not( "consumer" = Role )’>
<xsl:value-of select="filegateway.email.producerFilename"/><xsl:text> </xsl:text><xsl:value-of select="Filename"/>
</xsl:if>
<xsl:if test=’not( "producer" = Role )’>
<xsl:value-of select="filegateway.email.consumerFilename"/><xsl:text> </xsl:text><xsl:value-of select="ConsumerFilename"/>
</xsl:if>
<xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.timestamp"/><xsl:text> </xsl:text><xsl:value-of select="Time"/>
=============================================================================== <xsl:text>&#xa;</xsl:text>
<xsl:value-of select="filegateway.email.myFGHyperlinkMsg"/><xsl:text>&#xa;</xsl:text>
<xsl:value-of select="TargetURL"/>

<xsl:text>&#xa;</xsl:text>
<xsl:text>&#xa;</xsl:text>
<xsl:text>&#xa;</xsl:text>
<xsl:text>&#xa;</xsl:text>
<xsl:text>&#xa;</xsl:text>
<xsl:text>&#xa;</xsl:text>
<xsl:text>&#xa;</xsl:text>

</xsl:template>

</xsl:stylesheet>

Implement AS2
About this task

You can use Sterling File Gateway as a routing mechanism to send and receive AS2
messages through Sterling B2B Integrator. Applicability Statement 2 (AS2) EDIINT
(AS2) technology is a protocol for securely exchanging data with non-repudiation
of receipt over the Internet.

Sterling B2B Integrator with AS2 is a message management system enabling the
exchange of a variety of documents between trading partners using secure AS2
EDIINT technology. Sterling B2B Integrator with AS2 uses the Internet as a
transport mechanism, ensures privacy and security of documents exchanged, and
provides a means of non-repudiation. Using AS2 with Sterling B2B Integrator and
Sterling File Gateway extends your investments by sending and receiving
documents and interacting with your existing processes. Basically, you put a
document into a specific mailbox to send it to a specific partner and you receive
documents from partners in partner-specific mailboxes.

To use the features described in this topic, you must have a license for Sterling B2B
Integrator with an additional license for AS2 and for Sterling File Gateway, and
have them both installed.

For Sterling File Gateway to interoperate with Sterling B2B Integrator using AS2,
specific mailboxes are configured as integration points. The following diagram
shows the flow of outbound AS2 messages between Sterling File Gateway and
other systems.
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The following diagram shows the flow of inbound AS2 messages between Sterling
File Gateway and other systems.

Notice that in each of these scenarios, the mailbox path is the integration point
between Sterling File Gateway and Sterling B2B Integrator. Specifying the correct
mailbox paths in the routing channel templates establishes the connection between
the systems.

Prerequisites

Performing this procedure requires knowledge of Sterling B2B Integrator with AS2.

You should be familiar with configuring and verifying an AS2 setup prior to
configuring Sterling File Gateway with the AS2 partner.

The AS2 partner must be setup to use mailboxes instead of the file system.

An AS2 transfer from the AS2 Partner should be verified to successfully transfer
from the AS2 Partner's mailbox prior to configuring Sterling File Gateway with the
AS2 partner.

See Using AS2 in the Sterling B2B Integrator 5.2 online library.
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Use of Sterling File Gateway is not strictly limited to the selections provided in this
procedure. To simplify your initial use of AS2 with Sterling File Gateway, some
suggested selections are provided.

Procedure

To set up Sterling File Gateway for file transfers using AS2:

Procedure
1. From within Sterling File Gateway, select Tools > B2B Console.
2. In Sterling B2B Integrator, select Trading Partners > AS2 to create an AS2

partner. For example, you may create a partner name of AS2Partner. You can
use any valid user name that is not already in use in Sterling File Gateway.
During the AS2 profile creation:
a. On the Identification page, select Store AS2 Messages in a Mailbox.
b. On the Mailbox page, select Use Default Inbound/Outbound Mailboxes.

This selection will create a mailbox path of
/AS2/AS2Partner/Inbound

and
/AS2/AS2Partner/Outbound

These mailbox paths will need to be referenced in the routing channel
templates.

Note: Partners created in the AS2 Edition do not belong to any Sterling File
Gateway Community, and therefore cannot utilize PGP encryption, which
relies on communities for key management.

3. Update the AS2 user account created during the AS2 Partner creation. In
Sterling B2B Integrator, the user account in the example will be named:
AS2Partner_B2B.
a. Select Accounts > User Accounts. Locate and edit the AS2 user account.
b. Add the AS2Partner user to the File Gateway Partner Users group.
c. To enable this partner to access myFileGateway, grant access to the

/Inbound and /Outbound mailboxes listed in step 2b.
d. On the User Information screen, select the AS2Partner in the Identity

drop-down list, and save.

Note: The AS2 partner cannot be edited from the Sterling File Gateway
Community or Partner management screens and must be edited from the AS2
partner management screens in Sterling B2B Integrator.

4. Optionally, you may find it useful to create a Sterling File Gateway partner
group to organize your AS2 partners. For example, create a group named AS2
Partners. In Sterling File Gateway, select Participants > Groups and click
Create.

5. Add AS2Partner to a Sterling File Gateway group.
a. Select Participants > Groups. Click Add Partners.
b. Select the AS2 partner and a Sterling File Gateway Group, for example AS2

Partners. Click Execute.
6. Have the Integration Architect create a routing channel template configured to

route inbound data received using AS2 or the outbound data sent to AS2.
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7. Have the Route Provisioner create routing channels configured to use the AS2
routing channel templates.

Results

Partners can utilize AS2 for inbound or outbound messages.

Note: Messages received using AS2 will always have a file name of “Attachment”.
If you have set the following property:
mailbox.disallowDuplicateMessages=true

as recommended, messages can be overridden by subsequent messages with the
same name. To avoid this, set the property to:
mailbox.disallowDuplicateMessages=false

This setting applies to all of your file transfers, not just the AS2 ones, so consider
the implications before changing this property.

Note: You can track the progress of the file transfer delivery to the mailbox. In the
Arrived File details, locate the event code FG_0425. Select the associated Dataflow
hyperlink to obtain additional details. Select the workflow ID to view details in the
AS2 subsystem with details about the original document and movement to the
designated mailbox.

Note: Logs for Sterling File Gateway and myFileGateway will not include
information about AS2 transfers. Sterling File Gateway routes the data from one
mailbox to another and does not initiate or participate in the AS2 transfer.

About custom file layer types
Routing channel templates use file layer types to describe producer and consumer
file structures. The following file types are supported when you install :
v Container type layers - contain other container or non-container layers. For

example, a PGP layer can contain a ZIP layer and a ZIP layer can contain a
TEXT layer. A zip file can only contain multiple files if it is the outermost layer.
The standard container types are:
– ZIP
– GZIP
– PGP

v Non-container type layers - or primitive, do not contain any nested layers. The
standard non-container layers are:
– Text
– Unknown

The following graphic shows the relationship between the file layers for the
producer and the consumer and the processing that Sterling File Gateway performs
between each layer:
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If you have additional requirements, request that your System Administrator add
custom file layer types. When they are added, the new file layer types will be
available when you create new routing channel templates. The custom file layers
can be container or non-container type, and can be used for either or both the
producer or consumer file layers. System Administrators can create a maximum of
100 custom layer types.

Restrictions for Custom File Layer Types

The following constraints apply to custom file layer types:
v Custom file layer types can be container or non-container types.
v A custom file layer type can be used for the producer layer, the consumer layer,

or both.
v A custom container layer type must be configured with a business process that

will perform the appropriate function on the container layer.
v A custom non-container layer type on the producer side may map to a custom

non-container layer type on the consumer side, but a business process must be
specified to perform the appropriate translation from one format to the other.

v The name provided for custom file layer types must begin with “FGC_”. This
indicates that table entries for the LAYER_TYPE column in the FG_P_FLR_TYPE
and FG_C_FLR_TYPE tables must begin with “FGC_”. The maximum length for
LAYER_TYPE is 10 characters, including the "FGC_".

v You can define a maximum of 100 custom layers types, and each type can have
a maximum of 10 parameters, including the required parameters.

v All parameter values for custom file layer type tables should conform to the
corresponding maximum character length specified in the tables below.

v Every producer file layer type must specify the parameters in the following table
for the producer file structure in the FG_P_FLR_PRM_TYPE table and
FgProducerFileLayerParameterType XML element:

Ordinal Value Parameter

0 File name pattern as regular expression

1 File name pattern group fact names, comma
delimited
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v Every consumer file layer type must specify the parameter in the following table
for the consumer file structure in the FG_C_FLR_PRM_TYPE table and
FgConsumerFileLayerParameterType XML element:

Ordinal Value Parameter

0 File name format

v Parameters that correspond to ordinal value 0 are displayed in bold in the UI
and are required. Other parameters added for custom file layer types cannot be
specified to display in bold.

v You cannot can be edit or delete a file layer type if it is used in a template.

Business Processes Used for Custom File Layers

To create custom file layer types, create the business processes to perform the
functions on the custom layers.
v Translation - converts a file in the producer non-container layer to a file in the

consumer non-container layer
v Container layer transformation - unwraps the producer container layer to reveal

the files within it
v Container layer creation - creates the consumer container layer
v Consumer identification - defines the manner in which the characteristics of the

layer identify the consumer to deliver it to

Plan the mappings from your layers in the following sequence:
v Producer container
v Producer non-container
v Consumer non-container
v Consumer container

Sterling File Gateway invokes custom file layer business processes synchronously,
waiting for each business process to complete before continuing with the next one.
Consequently, all business processes that operate on custom file layers must:
v Complete as quickly as possible. While Sterling File Gateway waits for the

business process to complete, finite resources like threads and memory are
utilized. The longer the custom file layer business process waits, the longer
Sterling File Gateway must wait. This use of resources reduces overall
performance and throughput.

v Do not call the Sleep service or the Wait service from the business process.
v Set recovery levels to "manual". Settings of "auto recover" and "auto resume"

slow down recovery after a shutdown.
v Set the business process to execute on any queue except 3 or 4.

Consumer identification business processes must also:
v Not manipulate the document, such as changing its name. While doing this may

work in specific circumstances, future releases may change that behavior. What
Sterling File Gateway does or does not do with the document after calling the
consumer identification business process should be treated as an implementation
detail subject to change.

v Not be coded to handle the case where the consumer cannot be found; if the
ConsumerName element is empty or missing, Sterling File Gateway raises the
appropriate event to report that the consumer could not be determined.
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Container File Layer Types for Producer File Structure

To add a container file layer type for the Producer File Structure, three tables must
be updated:
v FG_P_FLR_TYPE
v FG_P_FLR_PRM_TYPE
v FG_P_FLR_TRANS

Table 1. FG_P_FLR_TYPE. This table specifies the new file layer type. The value provided in this table for
P_FLR_TYPE_KEY will need to be repeated in the FG_P_FLR_PRM_TYPE and FG_P_FLR_TRANS tables to
properly configure a custom file layer type. This table contains the following parameters:

Parameter Example Where in UI Type
Max
Characters

P_FLR_TYPE_KEY DR13D_GUID Not visible char 24

LAYER_TYPE FGC_DR13D Not visible varchar 10

IS_CONTAINER Y If Y, PFS configuration
requires selection of inner
layer type

char 1

CONTAINS_NAME N Not visible char 1

DISP_LABEL Double Rot13 Decrypt Not visible varchar 255

DESCRIPTION Double Rot13 Decrypt File layer drop down menu varchar 255

LOCKID 0 Not visible int 5

CREATETS 2008-09-22 17:48:45 Not visible datetime 19

MODIFYTS 2008-09-22 17:48:45 Not visible datetime 19

CREATEUSERID SYSTEM Not visible varchar 40

MODIFYUSERID SYSTEM Not visible varchar 40

CREATEPROGID XMLMigrator Not visible varchar 40

MODIFYPROGID XMLMigrator Not visible varchar 40

Table 2. FG_P_FLR_PRM_TYPE. This table specifies the individual parameters for the new producer file layer type.
Multiple entries may be made for any file layer type. At least two entries are required for the two parameters that are
automatically displayed with standard producer file layer types:

v File name pattern as regular expression

v File name pattern group fact names, comma delimited. Each entry for a file layer type requires a new ordinal,
increasing in increments of one. Parameters are displayed in the UI in the order indicated by the ordinal (0 is the
first parameter in the UI, 1 is the second, and so forth).

The FG_P_FLR_PRM_TYPE table must specify a value for the P_FLR_TYPE_KEY parameter that matches the
value for the P_FLR_TYPE_KEY parameter in the FG_P_FLR_TYPE table.

Parameter Name Example 1 Example 2
Where Visible in the
UI Type

Max
Characters

P_FLR_PRM_TYPE_KEY DR13D_FP_GUID DR13D_FPF_GUID Not visible char 24

P_FLR_TYPE_KEY DR13D_GUID DR13D_GUID Not visible char 24

ORDINAL 0 1 Controls order of
appearance in UI for
PFS configuration

int 9

DESCRIPTION File name pattern as
regular expression

File name pattern group
fact names, comma
delimited

PFS configuration varchar 255

DISPLAY_TYPE String String Not visible varchar 255
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Table 2. FG_P_FLR_PRM_TYPE (continued). This table specifies the individual parameters for the new producer
file layer type. Multiple entries may be made for any file layer type. At least two entries are required for the two
parameters that are automatically displayed with standard producer file layer types:

v File name pattern as regular expression

v File name pattern group fact names, comma delimited. Each entry for a file layer type requires a new ordinal,
increasing in increments of one. Parameters are displayed in the UI in the order indicated by the ordinal (0 is the
first parameter in the UI, 1 is the second, and so forth).

The FG_P_FLR_PRM_TYPE table must specify a value for the P_FLR_TYPE_KEY parameter that matches the
value for the P_FLR_TYPE_KEY parameter in the FG_P_FLR_TYPE table.

Parameter Name Example 1 Example 2
Where Visible in the
UI Type

Max
Characters

DISPLAY_LABEL File name pattern File name pattern fact
names

Not visible varchar 255

PARAM_NAME FILENAME_PATTERN FILENAME_PATTERN
_FACTNAMES

Not visible varchar 255

DEFAULT_VALUE .+ null Not visible varchar 255

ALLOWABLE_VALUES null null Not visible varchar 255

LOCKID 0 0 Not visible int 5

CREATETS 2008-09-22 17:48:45 2008-09-22 17:48:45 Not visible datetime 19

MODIFYTS 2008-09-22 17:48:45 2008-09-22 17:48:45 Not visible datetime 19

CREATEUSERID SYSTEM SYSTEM Not visible varchar 40

MODIFYUSERID SYSTEM SYSTEM Not visible varchar 40

CREATEPROGID XMLMigrator XMLMigrator Not visible varchar 40

MODIFYPROGID XMLMigrator XMLMigrator Not visible varchar 40

Restriction: DEFAULT_VALUE and ALLOWABLE_VALUES are required to be in
the table, but are not supported in the application.

Table 3. FG_P_FLR_TRANS. This table specifies the business process that should be used to perform the work
necessary to process the new producer container file layer type. This table must be provided a value for the
P_FLR_TYPE_KEY parameter that matches the value for the P_FLR_TYPE_KEY parameter in the
FG_P_FLR_TYPE table. It takes the following parameters:

Parameter Name Example Where Visible in the UI Type
Max
Characters

P_FLR_TRANS_KEY SDKFJSLKFJ_GUID Not visible char 24

P_FLR_TYPE_KEY DR13D_GUID Not visible char 24

BP_NAME DoubleRot13Decrypt Not visible varchar 255

LOCKID 0 Not visible int 5

CREATETS 2008-09-22 17:48:45 Not visible datetime 19

MODIFYTS 2008-09-22 17:48:45 Not visible datetime 19

CREATEUSERID admin Not visible varchar 40

MODIFYUSERID admin Not visible varchar 40

CREATEPROGID admin Not visible varchar 40

MODIFYPROGID admin Not visible varchar 40

Non-Container File Layer Types for Producer File Structure

Creating a non-container file layer type is similar to creating a container file layer
type, with two exceptions:
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v The value for the IS_CONTAINER parameter in the FG_P_FLR_TYPE should be
set to N (No).

v An entry must be made in a new table, FG_C_FLR_TRANS, instead of the
FG_P_FLR_TRANS table.

To add a non-container file layer type for the Producer File Structure, three tables
must be updated:
v FG_P_FLR_TYPE
v FG_P_FLR_PRM_TYPE
v FG_C_FLR_TRANS

Table 4. FG_P_FLR_TYPE. This table specifies the new producer file layer type.

Parameter Name Example Where Visible in the UI Type
Max
Characters

P_FLR_TYPE_KEY BLOCK_GUID Not visible char 24

LAYER_TYPE FGC_BLOCK Not visible varchar 10

IS_CONTAINER N If N, PFS configuration
recognizes as inner layer
type

char 1

CONTAINS_NAME N Not visible char 1

DISP_LABEL Blocked Text File layer drop down menu varchar 255

DESCRIPTION Blocked Text Description Not visible varchar 255

LOCKID 0 Not visible int 5

CREATETS 2008-09-22 17:48:45 Not visible datetime 19

MODIFYTS 2008-09-22 17:48:45 Not visible datetime 19

CREATEUSERID SYSTEM Not visible varchar 40

MODIFYUSERID SYSTEM Not visible varchar 40

CREATEPROGID XMLMigrator Not visible varchar 40

MODIFYPROGID XMLMigrator Not visible varchar 40

Table 5. FG_P_FLR_PRM_TYPE. This table specifies the individual parameters for the new file layer type. Multiple
entries may be made for any file layer type. At least two entries are required for the two parameters that are
automatically displayed with standard file layer types:

v File name pattern as regular expression

v File name pattern group fact names, comma delimited. Each entry for a file layer type requires a new ordinal,
increasing in increments of one. Parameters are displayed in the UI in the order indicated by the ordinal (0 is the
first parameter in the UI, 1 is the second, and so forth).

This table must specify a value for the P_FLR_TYPE_KEY parameter that matches the value for the
P_FLR_TYPE_KEY parameter in the FG_P_FLR_TYPE table.
Restriction: DEFAULT_VALUE and ALLOWABLE_VALUES are required to be in the table, but are not supported in
the application.

Parameter Name Example 1 Example 2
Where Visible in the
UI Type

Max
Characters

P_FLR_PRM_TYPE_KEY BLOCK_FP_GUID BLOCK_FPF_GUID Not visible char 24

P_FLR_TYPE_KEY BLOCK_GUID BLOCK_GUID Not visible char 24

ORDINAL 0 1 Controls order of
appearance in UI for
PFS configuration

int 9
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Table 5. FG_P_FLR_PRM_TYPE (continued). This table specifies the individual parameters for the new file layer
type. Multiple entries may be made for any file layer type. At least two entries are required for the two parameters
that are automatically displayed with standard file layer types:

v File name pattern as regular expression

v File name pattern group fact names, comma delimited. Each entry for a file layer type requires a new ordinal,
increasing in increments of one. Parameters are displayed in the UI in the order indicated by the ordinal (0 is the
first parameter in the UI, 1 is the second, and so forth).

This table must specify a value for the P_FLR_TYPE_KEY parameter that matches the value for the
P_FLR_TYPE_KEY parameter in the FG_P_FLR_TYPE table.
Restriction: DEFAULT_VALUE and ALLOWABLE_VALUES are required to be in the table, but are not supported in
the application.

Parameter Name Example 1 Example 2
Where Visible in the
UI Type

Max
Characters

DESCRIPTION File name pattern as
regular expression

File name pattern group
fact names, comma
delimited

PFS configuration varchar 255

DISPLAY_TYPE String String Not visible varchar 255

DISPLAY_LABEL File name pattern File name pattern fact
names

Not visible varchar 255

PARAM_NAME FILENAME_PATTERN FILENAME_PATTERN
_FACTNAMES

Not visible varchar 255

DEFAULT_VALUE .+ null Not visible varchar 255

ALLOWABLE_VALUES null null Not visible varchar 255

LOCKID 0 0 Not visible int 5

CREATETS 2008-09-22 17:48:45 2008-09-22 17:48:45 Not visible datetime 19

MODIFYTS 2008-09-22 17:48:45 2008-09-22 17:48:45 Not visible datetime 19

CREATEUSERID SYSTEM SYSTEM Not visible varchar 40

MODIFYUSERID SYSTEM SYSTEM Not visible varchar 40

CREATEPROGID XMLMigrator XMLMigrator Not visible varchar 40

MODIFYPROGID XMLMigrator XMLMigrator Not visible varchar 40

Table 6. FG_C_FLR_TRANS. This table specifies the legitimate mapping between the producer and consumer inner
layers. Only layers with a defined mapping can be configured in the routing channel template. It also specifies the
business process that should be used to perform the work necessary to translate the producer file layer type into the
corresponding consumer file layer type. This table must be provided a value for the P_FLR_TYPE_KEY parameter
that matches the value for the P_FLR_TYPE_KEY parameter in the FG_P_FLR_TYPE table and a value for the
C_FLR_TYPE_KEY parameter that matches the value for the C_FLR_TYPE_KEY parameter in the
FG_C_FLR_TYPE table. The consumer file layer type specified is required to be a custom type.

Parameter Name Example Where Visible in the UI Type
Max
Characters

C_FLR_TRANS_KEY asdfnlsadjfs_GUID Not visible char 24

P_FLR_TYPE_KEY BLOCK_GUID Not visible char 24

C_FLR_TYPE_KEY STREAM_GUID Not visible char 24

BP_NAME BaseMFT_Preprocessor Not visible varchar 255

LOCKID 0 Not visible int 5

CREATETS 2008-09-22 17:48:45 Not visible datetime 19

MODIFYTS 2008-09-22 17:48:45 Not visible datetime 19

CREATEUSERID admin Not visible varchar 40

MODIFYUSERID admin Not visible varchar 40
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Table 6. FG_C_FLR_TRANS (continued). This table specifies the legitimate mapping between the producer and
consumer inner layers. Only layers with a defined mapping can be configured in the routing channel template. It also
specifies the business process that should be used to perform the work necessary to translate the producer file layer
type into the corresponding consumer file layer type. This table must be provided a value for the P_FLR_TYPE_KEY
parameter that matches the value for the P_FLR_TYPE_KEY parameter in the FG_P_FLR_TYPE table and a value
for the C_FLR_TYPE_KEY parameter that matches the value for the C_FLR_TYPE_KEY parameter in the
FG_C_FLR_TYPE table. The consumer file layer type specified is required to be a custom type.

Parameter Name Example Where Visible in the UI Type
Max
Characters

CREATEPROGID admin Not visible varchar 40

MODIFYPROGID admin Not visible varchar 40

Container File Layer Types for Consumer File Structure

To add a container file layer type for the Consumer File Structure, three tables
must be updated:
v FG_C_FLR_TYPE
v FG_C_FLR_PRM_TYPE
v FG_C_FLR_TRANS

Table 7. FG_C_FLR_TYPE. This table specifies the new file layer type.

Parameter Name Example Where Visible in the UI Type
Max
Characters

C_FLR_TYPE_KEY DR13E_GUID Not visible char 24

LAYER_TYPE FGC_DR13E Not visible varchar 10

IS_CONTAINER Y If Y, PFS configuration
requires selection of inner
layer type

varchar 10

DISP_LABEL Double Rot13 Encryption File layer drop down menu varchar 255

DESCRIPTION Double Rot13 Encryption
Description

Not visible varchar 255

LOCKID 0 Not visible int 5

CREATETS 2008-09-22 17:48:45 Not visible datetime 19

MODIFYTS 2008-09-22 17:48:45 Not visible datetime 19

CREATEUSERID SYSTEM Not visible varchar 40

MODIFYUSERID SYSTEM Not visible varchar 40

CREATEPROGID XMLMigrator Not visible varchar 40

MODIFYPROGID XMLMigrator Not visible varchar 40
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Table 8. FG_C_FLR_PRM_TYPE. This table specifies the individual parameters for the new producer file layer type.
Multiple entries may be made for any file layer type. At least one entry is required for the parameter that is
automatically displayed with standard consumer file layer types, File name format. Each entry for a file layer type
requires a new ordinal, increasing in increments of one. Parameters are displayed in the UI in the order indicated by
the ordinal (0 is the first parameter in the UI, 1 is the second, and so on). This table must be provided a value for the
C_FLR_TYPE_KEY parameter that matches the value for the C_FLR_TYPE_KEY parameter in the
FG_C_FLR_TYPE table.
Restriction: DEFAULT_VALUE and ALLOWABLE_VALUES are required to be in the table, but are not supported in
the application.

Parameter Name Example Where Visible in the UI Type
Max
Characters

C_FLR_PRM_TYPE_KEY DR13E_FF_GUID Not visible char 24

C_FLR_TYPE_KEY DR13E_GUID Not visible char 24

ORDINAL 0 Controls order of
appearance in UI for PFS
configuration

int 9

DESCRIPTION File name format PFS configuration varchar 255

DISPLAY_TYPE String Not visible varchar 255

DISPLAY_LABEL File name format Not visible varchar 255

PARAM_NAME FILENAME_FORMAT Not visible varchar 255

DEFAULT_VALUE ${ProducerFilename} Not visible varchar 255

ALLOWABLE_VALUES null Not visible varchar 255

LOCKID 0 Not visible int 5

CREATETS 2008-09-22 17:48:45 Not visible datetime 19

MODIFYTS 2008-09-22 17:48:45 Not visible datetime 19

CREATEUSERID SYSTEM Not visible varchar 40

MODIFYUSERID SYSTEM Not visible varchar 40

CREATEPROGID XMLMigrator Not visible varchar 40

MODIFYPROGID XMLMigrator Not visible varchar 40

Table 9. FG_C_FLR_TRANS. This table specifies the business process that should be used to perform the work
necessary to process the new consumer file layer type. This table must be provided a value for the
C_FLR_TYPE_KEY parameter that matches the value for the C_FLR_TYPE_KEY parameter in the
FG_C_FLR_TYPE table.

Parameter Name Example Where Visible in the UI Type
Max
Characters

C_FLR_TRANS_KEY werioweuro_GUID Not visible char 24

P_FLR_TYPE_KEY DR13D_GUID Not visible char 24

C_FLR_TYPE_KEY DR13E_GUID Not visible char 24

BP_NAME DoubleRot13Encrypt Not visible varchar 255

LOCKID 0 Not visible int 5

CREATETS 2008-09-22 17:48:45 Not visible datetime 19

MODIFYTS 2008-09-22 17:48:45 Not visible datetime 19

CREATEUSERID admin Not visible varchar 40

MODIFYUSERID admin Not visible varchar 40

CREATEPROGID admin Not visible varchar 40
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Non-Container File Layer Types for Consumer File Structure

Creating a non-container file layer type is similar to creating a container file layer
type, with two exceptions:
v The value for the IS_CONTAINER parameter in the FG_C_FLR_TYPE should be

set to N (No).
v A value must be specified for the P_FLR_TYPE_KEY in the FG_C_FLR_TRANS

table.

To add a non-container file layer type for the Producer File Structure, three tables
must be updated:
v FG_C_FLR_TYPE
v FG_C_FLR_PRM_TYPE
v FG_C_FLR_TRANS

Table 10. FG_C_FLR_TYPE. This table specifies the new consumer file layer type.

Parameter Name Example Where Visible in the UI Type
Max
Characters

C_FLR_TYPE_KEY STREAM_GUID Not visible char 24

LAYER_TYPE FGC_STREAM Not visible varchar 10

IS_CONTAINER N If N, CFS configuration
recognizes as inner layer
type

varchar 10

DISP_LABEL Streamed Text File layer drop down menu varchar 255

DESCRIPTION Streamed Text Description Not visible varchar 255

LOCKID 0 Not visible int 5

CREATETS 2008-09-22 17:48:45 Not visible datetime 19

MODIFYTS 2008-09-22 17:48:45 Not visible datetime 19

CREATEUSERID SYSTEM Not visible varchar 40

MODIFYUSERID SYSTEM Not visible varchar 40

CREATEPROGID XMLMigrator Not visible varchar 40

MODIFYPROGID XMLMigrator Not visible varchar 40

Table 11. FG_C_FLR_PRM_TYPE. This table specifies the individual parameters for the new consumer file layer
type. Multiple entries may be made for any file layer type. At least one entry is required for the parameter that is
automatically displayed with standard consumer file layer types, File name format. Each entry for a file layer type
requires a new ordinal, increasing in increments of one. Parameters are displayed in the UI in the order indicated by
the ordinal (0 is the first parameter in the UI, 1 is the second, and so on). This table must be provided a value for the
C_FLR_TYPE_KEY parameter that matches the value for the C_FLR_TYPE_KEY parameter in the
FG_C_FLR_TYPE table. This table takes the following parameters:
Restriction: DEFAULT_VALUE and ALLOWABLE_VALUES are required to be in the table, but are not supported in
the application.

Parameter Name Example Where Visible in the UI Type
Max
Characters

C_FLR_PRM_TYPE_KEY STREAM_FF_GUID Not visible char 24

C_FLR_TYPE_KEY STREAM_GUID Not visible char 24

ORDINAL 0 Controls order of
appearance in UI for PFS
configuration

int 9
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Table 11. FG_C_FLR_PRM_TYPE (continued). This table specifies the individual parameters for the new consumer
file layer type. Multiple entries may be made for any file layer type. At least one entry is required for the parameter
that is automatically displayed with standard consumer file layer types, File name format. Each entry for a file layer
type requires a new ordinal, increasing in increments of one. Parameters are displayed in the UI in the order
indicated by the ordinal (0 is the first parameter in the UI, 1 is the second, and so on). This table must be provided a
value for the C_FLR_TYPE_KEY parameter that matches the value for the C_FLR_TYPE_KEY parameter in the
FG_C_FLR_TYPE table. This table takes the following parameters:
Restriction: DEFAULT_VALUE and ALLOWABLE_VALUES are required to be in the table, but are not supported in
the application.

Parameter Name Example Where Visible in the UI Type
Max
Characters

DESCRIPTION File name format PFS configuration varchar 255

DISPLAY_TYPE String Not visible varchar 255

DISPLAY_LABEL File name format Not visible varchar 255

PARAM_NAME FILENAME_FORMAT Not visible varchar 255

DEFAULT_VALUE ${ProducerFilename} Not visible varchar 255

ALLOWABLE_VALUES null Not visible varchar 255

LOCKID 0 Not visible int 5

CREATETS 2008-09-22 17:48:45 Not visible datetime 19

MODIFYTS 2008-09-22 17:48:45 Not visible datetime 19

CREATEUSERID SYSTEM Not visible varchar 40

MODIFYUSERID SYSTEM Not visible varchar 40

CREATEPROGID XMLMigrator Not visible varchar 40

MODIFYPROGID XMLMigrator Not visible varchar 40

Table 12. FG_C_FLR_TRANS. This table specifies the legitimate mapping between the producer and consumer
inner layers. Only layers with a defined mapping can be configured in the routing channel template. It also specifies
the business process that should be used to perform the work necessary to translate the producer file layer type into
the corresponding consumer file layer type. This table must be provided a value for the P_FLR_TYPE_KEY
parameter that matches the value for the P_FLR_TYPE_KEY parameter in the FG_P_FLR_TYPE table and a value
for the C_FLR_TYPE_KEY parameter that matches the value for the C_FLR_TYPE_KEY parameter in the
FG_C_FLR_TYPE table.

Parameter Name Example Where Visible in the UI Type
Max
Characters

C_FLR_TRANS_KEY asdfnlsadjfs_GUID Not visible char 24

P_FLR_TYPE_KEY BLOCK_GUID Not visible char 24

C_FLR_TYPE_KEY STREAM_GUID Not visible char 224

BP_NAME BaseMFT_Preprocessor Not visible varchar 255

LOCKID 0 Not visible int 5

CREATETS 2008-09-22 17:48:45 Not visible datetime 19

MODIFYTS 2008-09-22 17:48:45 Not visible datetime 19

CREATEUSERID admin Not visible varchar 40

MODIFYUSERID admin Not visible varchar 40

CREATEPROGID admin Not visible varchar 40

MODIFYPROGID admin Not visible varchar 40

Version 2.2.3 Updates 39



Translation
Sterling File Gateway V2.2.3 or later supports translation. Translation includes
support for several languages that can be used for the user interface and for
notifications.

Languages

Sterling File Gateway supports:
v English
v German
v Simplified Chinese
v Traditional Chinese
v French
v Spanish
v Italian
v Portuguese-Brazil
v Japanese
v Korean
v Dutch (V5.2.4.2 or later)
v Arabic (myFile Gateway UI only - V2.2.5, Interim Fix 6 or later)

All resources needed for the supported languages are part of the standard product
installation. See Support for Foreign Languages in the Sterling B2B Integrator 5.2
online library for more information.

User Interface Effects

You can view the Sterling File Gateway user interface in one of the ten supported
languages in addition to English, and myFile Gateway in 11 supported languages.
The language used for the user interface is based on these settings:

Table 13. User interface language settings

Functional Area Language Setting User Interface Language Effect

Sterling File
Gateway, including
Partner and
Community
management pages

Client application
(browser) setting

For operator users, Sterling File Gateway and
Partner and Community management pages
are displayed in the preferred language of the
client application.
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Table 13. User interface language settings (continued)

Functional Area Language Setting User Interface Language Effect

Sterling B2B
Integrator

Preferred Language
setting located in
Sterling B2B
Integrator Accounts
> My Account

The Sterling B2B Integrator user interface,
available to administrative users only, is
displayed in the language specified by the
Preferred Language setting for the account. The
Preferred Language drop down has the nine
supported languages in addition to English and
the Use Client Application Settings option. If you
use the Client Application Settings option, the
user interface uses the language specified by
the browser.

This sets the preferred language for Sterling
B2B Integrator pages and for the Sterling File
Gateway and EBICS event email notifications
specified on the Sterling File Gateway Profile
page.

Preferred Language defaults to English for
newly created users and to Use client
Application Settings for out-of-the-box users.

Notifications
received via email

Language for
notifications located
in Sterling File
GatewayProfile >
Notifications

Notifications for Sterling File Gateway and
EBICS events are sent in the language specified
by this setting. Sterling File Gateway users can
modify this setting on the Profile >
Notifications tab. Any modifications made to
the Profile > Notifications language setting
also modify the Preferred Language setting in
Sterling B2B Integrator Accounts > My
Account and vice versa. The language set in
Sterling File Gateway with Profile >
Notifications affects the Sterling B2B Integrator
user interface and the language set with the
Preferred Language in Sterling B2B Integrator
affects the language used for notifications by
email in Sterling File Gateway.

Additional Calendar Support (V2.2.5, Interim Fix 6 or later)

Calendars in Sterling File Gateway are displayed as Gregorian by default. In
myFile Gateway, however, you can choose to display calendars as Hijiri by setting
the following property in the filegateway.property.in file:
hijiriCalendarSupport=true

By default, this property is set to false.

Provisioning for PDF Format Reports in Double-Byte Character
Set (DBCS) Languages

New instructions for preparing to create reports with double-byte character set
(DBCS) languages. See Preparing for PDF format reports in double-byte character set
(DBCS) languages
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Splash Screen

As part of rebranding, the Splash screen can appear in one of the non-English
languages supported. The language is determined by the browser's language
settings. See the Rebranding Sterling File Gateway and myFilegateway for more
information.

Migrate Custom Protocols
Custom Protocols are not Community specific and can be migrated before the
Sterling File Gateway Community. The Custom Protocol should not be added to
the Community Resource Tag. Because Custom Protocols are custom configurations
within the system, the migration steps and the resources migrated will vary
between different implementations. Custom Protocol migration is a two-step
process because some of the migration is done through the user interface and some
is done outside of the user interface.

Guidelines and Requirements

Guidelines and requirements for Custom Protocol migration include:
v Custom Protocols are not Community specific, instead they are system specific;

they are available to all Communities on the system.
v Custom Protocol resources and files (or entries within the files) that you want to

migrate should be migrated and copied to the target system before migrating the
Sterling File Gateway Community.

v Custom Protocol resources should not be added to the Community Resource Tag
v The resources that define a Custom Protocol can vary from system to system, so

the specific resources to be migrated will vary between different
implementations. Therefore, all customized resources that are used by the
Custom Protocol must be migrated. This includes any all custom BP's and
Services used by the Custom Protocol.

v Because some of the configuration is managed outside of the user interface,
Custom Protocol Migration is a two step process.

v If the target system already contains the AFTExtensionsCustomer.xml and/or the
AFTExtensionsCustomer.properties file, then the entries from these files on the
source system will need to be added to these files on the target system. Only
completely new Customer Protocol entries should be added. Adding modified
(different) versions of previously existing Custom Protocol entries or updating
previously existing Custom Protocol entries in these files may lead to
unexpected behavior.

Resource Manager

Custom Protocols used by, or available to, the Sterling File Gateway Community
must be migrated to the target system before the Community is migrated. All of
the custom resources that are required for the Custom Protocol to work, must be
exported from the source system via the Resource File from the Sterling B2B
Integrator Resource Manager (for example, custom BPs or custom Services). These
custom resources can be added to a Resource Tag (non-Community Resource Tag)
or exported ad-hoc. These custom resource components are not subject to the same
constraints as the resources within an Sterling File Gateway Community.
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AFTExtensionCustomer Files

After the resources used by the Custom Protocol have been migrated to the target
system through the Resource Manager, both files, located within the Sterling B2B
Integrator installation directory, must be copied and moved from the file path
specified below on the source system to the same file path on the target system:

AFTExtensionsCustomer.xml
The AFTExtensionsCustomer.xml is located in the following directory
within the Sterling B2B Integrator installation directory:
<installation directory>/container/Applications/aft/WEB-INF/classes/
resources/xml

AFTExtensionsCustomer.properties
The AFTExtensionsCustomer.properties is located in the following
directory within the Sterling B2B Integrator installation directory:
<installation directory>/container/Applications/aft/WEB-INF/classes/
resources/

If these files contain any Custom Protocol configurations that are not intended to
be migrated, then both files must be updated with the removal of the unwanted
configurations. If the target system already contains the
AFTExtensionsCustomer.xml and/or the AFTExtensionsCustomer.properties file,
then the entries within these files on the source system will need to be added to
these files on the target system. Only completely new Customer Protocol entries
should be added to these files. Adding modified (different) versions of previously
existing Custom Protocol entries or updating previously existing Custom Protocol
entries in these files may lead to unexpected behavior.

After both AFTExtensionCustomer files have been moved to the appropriate
directory on the target system, the system must be stopped, and restarted after
running setupfiles and deployer.

Migrate SI Managed Resources
Sterling B2B Integrator customized resources used by the Sterling File Gateway
Community must exist on the target system before the Community is migrated.
These resources can be migrated to the target system or created new on the target
system.

Sterling B2B Integrator managed resources are any resources that are not created
within Sterling File Gateway; instead these resources are created and managed
within Sterling B2B Integrator. These might include, but are not limited to: AS2
partners, SSH profiles, SSH Authorized User Keys, certificates, Pre- and Post-
process BPs, customized server adapters, etc.

The Sterling B2B Integrator managed resources can be migrated via an
independent Resource Tag (non-Sterling File Gateway Community Resource Tag)
or migrated ad-hoc. The export of these components are not subject to the same
constraints as the resources within an Sterling File Gateway Community. Special
consideration should be made if any of these Sterling B2B Integrator managed
resources are added to the Sterling File Gateway Community Resource Tag as the
flexibility of the import may be affected. Specifically, in regards to when
overwriting or adding new resources. For example, if an Sterling B2B Integrator
managed resource is imported and requires the Update existing objects... flag set to
YES, then all objects within the Sterling File Gateway Community will be imported
and updated.
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Migrate a Sterling File Gateway Community
After migrating custom protocols, the Sterling File Gateway Community can be
migrated. There are specific resources types and settings that must be selected for a
successful migration. There are some differences in the migration settings based on
the version of Sterling B2B Integrator and Sterling File Gateway being migrated.

Guidelines

The guidelines for migrating a Sterling File Gateway community include:

System Guidelines and Requirements

Community Management For versions up to and including Sterling B2B Integrator
5.2.3 and Sterling File Gateway 2.2.3:

v Only a single community per Resource Tag can be
exported or imported at a time.

v The entire community as a whole must be exported
from the source system based on the Resource Tag and
the entire community as a whole must be imported to
the destination system. This means that all resources
within the Resource Tag must be exported and all
resources included within the resource file must be
imported.

v Individual partners cannot be independently or
individually selected and imported to the target system.
The entire community that the partner belongs to must
be imported.

For systems prior to Sterling B2B Integrator 5.2.3 and
Sterling File Gateway 2.2.3

v Only a single source system may be used in the
migration path. The Sterling File Gateway Community
on the target system cannot be updated with
communities from multiple Sterling File Gateway source
systems.

v All new resources that are created within the Sterling
File Gateway community must be created on the source
system and then migrated to the target system.
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System Guidelines and Requirements

Resource Tag The Resource Tag (Deployment > Resource Manager >
Resource Tags) is managed by Sterling File Gateway when
Community and Partner additions or updates are made.

v The Resource Tag itself must never be deleted.
Recreating a Sterling File Gateway Community Resource
Tag requires running SFGDBCheck.

v Resources should never be removed from a Resource
Tag associated with an Sterling File Gateway
Community. If a resource must be removed it should be
deleted from the Community, using the Sterling File
Gateway user interface. It will then be removed from the
Resource Tag. During a migration where a resource has
been removed on the source system, neither the Sterling
File Gateway Community nor the Resource Tag on the
target system will be updated with the removal; the
resource must be manually removed on the target
system from both the Sterling File GatewayCommunity
and the Resource Tag after the migration.

v Resources that are not managed by Sterling File
Gateway (non-Sterling File Gateway partners, mailboxes,
user accounts, etc....) must be manually added to the
Resource Tag.

For Sterling B2B Integrator 5009, 5103 and Sterling File
Gateway 523, and higher, If the Resource Tag already
exists on the target system (due to a previous migration),
that Resource Tag will be updated during the import with
the newly imported resources. The Resource Tag will not
be updated with removals, such as a partner that has been
deleted on the source system prior to migration.

For systems prior to Sterling B2B Integrator 5.2.3 and
Sterling File Gateway 2.2.3, if the Resource Tag already
exists on the target system (due to a previous migration),
that Resource Tag will need to be renamed prior to the
migration. This can lead to multiple Resource Tags, each
representing a portion of an Sterling File Gateway
Community.

Sterling B2B Integrator
Resources

All Sterling B2B Integrator customized resources used by,
or available to, the Sterling File Gateway Community must
exist on the target system before the Community is
migrated. These customized resources can either be
migrated to, or created new on the target system.

The migration of these Sterling B2B Integrator resources
can be performed by adding them to a Resource Tag
(non-Sterling File Gateway Community Resource Tag), or
migrating them ad-hoc.

Resource Tag management

No changes should be made to the Resource Tag. There are four Resource Types
required for successful migration and must be selected:

Other Resource Types can be added; their related resources and components must
also be included.
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Resource Tag configuration

There are four Resource Types required for successful migration and all four must
be selected:
v Trading Partner Data
v Accounts
v Mailboxes
v Communities

Other Resource Types can be added. Be sure to include any related resources and
components for the added Resource Types.

The Resource Types have required settings for migration:

Table 14. Resource Type required migration settings

Resource Selections

Trading Partner Data
Resources

There are two Trading Partner Data resources that are required
for migration and both must be selected:

Identities
By default, Identities are added to the Resource Tag for
all Trading Partners within the Community. All Identities
that are added to the Resource Tag by default are
required for a migration of a Community, so all
Identities must remain selected (be present in the “Must
Be Associated” field). Other Identities can be added as
needed. Be sure to add any related resources and/or
components for the Identity to the Resource Tag.

Packagings
By default, Packagings are added to the Resource Tag for
all Trading Partners within the Community. All
Packagings that are added to the Resource Tag by
default are required for a migration, so all Packagings
must remain selected (be present in the “Must Be
Associated” field). Other Packagings can be added as
needed. Be sure to add any related resources and/or
components for the packaging to the Resource Tag.

Other Partner Resources can be added as needed. Be sure to
include any related resources and/or components, such as an AS2
Partner, for any added Partner Resources.

Accounts Only the User option is required for migrating a Community
managed by Sterling File Gateway. All Users that are added to
the Resource Tag by default are required for a successful
migration of a Community, so all Users must remain selected (be
present in the “Must Be Associated” field). Other Users can be
added to the Resource Tag. Be sure to add any related resources
and/or components to the Resource Tag for the added Users.

If any other Account resources are selected, the Resource Tag
should be updated so that only the "Users" resource is selected.

It is recommended that Permissions and Groups not be added to
the Resource Tag for migration. They are not required and if
migrated between systems with different versions/patches, it
might lead to unexpected behavior.
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Table 14. Resource Type required migration settings (continued)

Resource Selections

Mailbox There are two Mailbox resources that are required for migration
and both must be selected:

Mailbox Virtual Roots
By default, Mailbox Virtual Roots are added to the
Resource Tag for all Partners in the Community. All
Mailbox Virtual Roots that are added to the Resource
Tag by default are required for a migration of a
Community, so all Mailbox Virtual Roots must remain
selected (be present in the “Must Be Associated” field).
Other Mailbox Virtual Roots can be added to the
Resource Tag.

Mailbox Metadata
By default, Mailbox Metadata are added to the Resource
Tag for all Trading Partners within the Community. All
Mailbox Metadata that are added to the Resource Tag by
default are required for a migration of a Community, so
all Mailbox Metadata must remain selected (be present
in the “Must Be Associated” field). Other Mailbox
Metadata can be added to the Resource Tag. Be sure to
add any related resources and/or components to the
Resource Tag for the added Mailbox Metadata.

Mailbox Routing Rules can be added as needed. Be sure to add
any related resources and/or components for the Mailbox
Routing Rules to the Resource Tag. For example, when adding a
custom Mailbox Routing Rule, the Business Process referenced by
the Mailbox Routing Rule must also be included.

The File Gateway Routing Rule should not be added to the
Resource Tag. This routing rule may be updated between
versions and/or patches. If it is migrated between systems with
different versions/patches, it might lead to unexpected behavior.

Communities By default, only the Community that the Resource Tag represents
will appear as an option. The Community is required for a
migration of a Community, so it must remain selected. If it is not
present, stop the migration and contact Support.

Resource Tag Export

The export must be performed by exporting via a Resource Tag. Always examine
the Export Report after generating the resource file and verify that no errors were
generated before continuing with the migration. If errors were generated in the
Export Report, contact Support to open a case and provide the export report and
the Resource File generated.

Resource Tag Import

All resources within the Resource Tag must be imported. All resources within the
resource file are required for the import to be successful, even if the purpose of the
migration is to insert new resources into the target system's Community without
changing existing resources. The Import All Resources option automatically selects
all resources in the resource file for importing. It is recommended that you always
use the Import All Resources option. If you do not use this option you will be
prompted to manually select all of the resources to import for each resource type.
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Table 15. Different behavior for duplicate Resource Tags on target systems

For Systems

If the target system already contains a
Resource Tag with the same name as the
one being imported ...

prior to Sterling B2B Integrator 5.2.3 and
Sterling File Gateway 2.2.3,

the Resource Tag on the target system must
be renamed before starting the import. Do
not delete the Resource Tag prior to
importing.

Sterling B2B Integrator 5009, 5103 and
Sterling File Gateway 523, and higher

the Resource Tag will be updated during the
import with the newly imported resources.
The Resource Tag will not be updated with
removals, such as a partner that has been
deleted on the source system prior to
migration.

During the import you will be asked "Some objects being imported may exist in
the system. Do you wish to update them?". This option can be set to either Yes or
No. Be careful when setting this to “Yes” because the resource file being imported
represents many resources within an Sterling File Gateway Community where all
of the resources must participate in the import process. Also, there may be planned
differences in configuration for some resources between the source and target
systems; for example, the Partner User passwords may differ between the source
and target systems.

Always examine the Import Report and verify that no errors were generated. If
errors were generated, contact Support to open a case and provide the import
report and the Resource File used.

Migrate Sterling File Gateway Configurations
After the Custom Protocols and Sterling File Gateway Community have been
migrated, the Sterling File Gateway Configurations can be migrated. The
configuration resources are not Community specific. It is recommended that these
resources be migrated separately from the Community.

Guidelines and Requirements

Guidelines and requirements for migrating Sterling File Gateway Configurations
include:

Sterling File Gateway Configurations are not added to a Resource Tag by default.
Sterling File Gateway Configuration objects are not “Community specific” and
carry with them additional constraints that affect the migration process. It is
recommended that the File Gateway Configurations not be added to the Resource
Tag and that they follow an independent (parallel) migration process. Sterling File
Gateway Configurations include:

Partner Groups
Partner Groups must be imported separately from the Community when
the migration process is used to add (insert) new configurations into the
Sterling File Gateway Community (I.E. not update (overwrite) the entire
Sterling File Gateway Community). Failure to import Partner Groups will
lead to a partner being disassociated from the Partner Group(s) that the
partner is included within, and the new Partner(s) will not show up as a
Partner within Sterling File Gateway
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Consumer Customer File Layers, Producer Customer File Layers, Routing
Channels, Routing Channel Templates

If the resource(s) exists on the target system with the same name, they first
must be deleted from the target system prior to the import. It is
recommended that these resources are deleted before the migration of the
Sterling File Gateway Community. The “Some objects being imported may
exist in the system. Do you wish to update them?” option does not apply
to these resources.

Partner Groups

After the successful migration of the Community (successfully exported and then
successfully imported), the Sterling File Gateway Configurations Partner Groups
must be migrated separately to the target system. Failure to import Partner Groups
will lead to a partner being disassociated from the Partner Group(s) that the
partner is included within, and the new Partner(s) will not show up as a Partner
within Sterling File Gateway.

The migration of the Partner Groups should be performed in a separate migration
(import/export process), either by creating a new Resource Tag that contains only
Partner Groups, or an ad hoc export/import (no Resource Tag configuration) can
be performed.

During a migration where a Partner Group with the same name already exists on
the target system, the “Some objects being imported may exist in the system. Do
you wish to update them?” option must be set to Yes. Not setting this setting to
yes will result in the selected Partner Groups not being updated on the target
system.

Other Configurations

After the migration of the Community and the Partner Groups, the remaining File
Gateway Configurations resources can be migrated to the target system. These
configurations are:
v Consumer Custom File Layers
v Producer Custom File Layers
v Routing Channels
v Routing Channel Templates

During a migration of any or all of these four resource types, if the resource exists
on the target system with the same name, first those resources must be deleted
from the target system prior to the import. The “Some objects being imported may
exist in the system. Do you wish to update them?” option does not apply to them.

Export and Import Resources
About this task

If you want to use the same configurations of partners, communities, partner
groups, routing channels, routing channel templates, or custom file layers in
multiple Sterling File Gateway installations, you can create them in one
installation, export them from there, and import them into other installations. This
is useful for first creating a test system and then moving the successful
configurations to a production system.
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It is a good practice to fully implement Sterling File Gateway in a test
environment. You can configure the required resources, test to confirm that
everything is functioning as you require, and then move to a production
environment. You may want to use a staging environment as another step in the
process.

Procedure
1. To export and import from Sterling File Gateway, select Tools > B2B Console

> Deployment > Resource Manager > Resource Tags.
2. Search for or select from the list the resource tag name (same as the

community name). When selecting a large number of resources to associate
with a resource tag, you may need to use the Tab key three times to view the
Finish button.

3. Click Edit next to the Resource Tag.
4. Edit the community resource tag to add partner groups, routing channel

templates, custom file layers, routing channels, business processes, maps,
service configurations, SSH resources, and any other relevant resources.

5. Select from the following according to your needs:
v Accounts (if created outside regular partner creation)
v Service Configurations
v Digital Certificates
v SSH Resources
v PGP Profiles
v Perimeter Servers
v Business Processes (if created for dynamic routing channel templates,

custom file layers, or other extensibility)
v Schedules
v Mailboxes (if created outside regular partner creation or regular routing

channel creation)
v Maps (if created for extensibility)

6. Select File Gateway Configurations to access selections of the following:
v Routing Channel Templates
v Consumer Custom File Layers
v Producer Custom File Layers
v Partner Groups
v Routing Channels

Note: A partner group is the only Sterling File Gateway object that is updated
upon import. All other Sterling File Gateway objects are not updated,
regardless of the specification for the “Update Existing Object” value. To
update any File Gateway object other than a group on the target system upon
import, you must first delete it from target system.

7. Continue through the wizard, using the right and left arrows to select the
components to include in the resource tag.

8. Click Finish to confirm the edits to the resource tag.

Note: When selecting a large number of resources to associate with a resource
tag, you may need to use the Tab key three times to view the Finish button.

9. From the Administration menu, select Deployment > Resource Manager >
Import/Export.
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10. Click Go! next to Export Resources.
11. Choose XML Document for the type of format.
12. Select Yes for tag name.
13. Choose the resource tag with the name of the community name you want to

export from the list.
14. Select whether to export private certificates.
15. Click Finish to confirm the report. The export file is created. Examine the

export report to confirm that there are no errors.
16. Save the export file to an accessible directory.
17. In the target system, import the resources by selecting Tools > B2B Console >

Deployment > Resource Manager > Import/Export.
When importing a community, a page is presented for each kind of resource
in the export file. Choose all the objects for each kind of resource so all objects
are imported. You cannot specify individual partners for import; all the
partners in the exported community are imported at once. Do not change the
name of the resource tag. When importing routing rules, do not import any
routing rules with a suffix of "_AFTRouter".

18. After importing, review the Import Report to verify a status of Success for
each resource. Correct any conditions noted in the report that did not result in
success.

Integration Architect help

Creating a Community
Integration Architects create, edit, and delete communities.

Procedure
1. From the main menu, select Participants > Communities.
2. Click add.
3. Complete the information in the wizard for the new community.

Field Description

Community Name A meaningful name to describe the community. Required.
Cannot be a name previously used in IBM Sterling B2B
Integrator. Do not use spaces, tabs, or the following special
characters:

! @ # % ^ * ( ) + ? , < > [ ] { } / ' \ " | ;

Secret key for PGP signing Select from list of keys assigned to AFTPGPProfile.
Required if any of the consuming partners belonging to this
community require PGP signed data from the Router. See
Prepare to Use PGP.

Secret key for PGP
decryption

Select from list of keys assigned to AFTPGPProfile.
Required if any of the producing partners belonging to this
community send PGP encrypted data to the Router. This
secret key may be the same or different from the one for
PGP signing. See Prepare to Use PGP.

Version 2.2.3 Updates 51



Field Description

Partner Initiates Protocol
Connections to Mailbox

Select to make this option available when creating Partners
belonging to this community. A unique mailbox is created
for Partners that initiate connections. Depending on other
selections, submailboxes are created for Partners to enable
them to drop files off for routing, or pick up files routed to
them.

Partner Listens for Protocol
Connections

Select to enable protocols available to listening Partners
belonging to this community. When selected, the following
choices are available when creating Partners belonging to
this community:

v FTP or FTPS

v Connect:Direct

v SSH/SFTP

v WebSphere MQ FTE

If the System Administrator adds other protocols to the
AFTExtensionsCustomer.xml file, they are also provided as
choices here.

Should member partners
receive notifications that they
are subscribed to?

This selection has no effect in Sterling File Gateway.

4. Confirm the information and save.
5. Close the Community window to return to Sterling File Gateway.

Results

Route Provisioners can now create partners using the community.

Route Provisioner help

Creating a Partner
About this task

You can create partners in a test system and migrate them to a production system
using Export and Import, or you can create partners directly in a production
system. To avoid conflicts between systems, you should create partners in either
the source or target system of Export/Import, not both.

To create a partner:

Procedure
1. From the main menu, select Participants > Partners

2. Click Create.
3. From the Community list, select the community to which this Partner will

belong.
4. Complete the steps in the wizard to enter the information for the Partner.
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Field Description

Partner Name A unique name with a maximum of 100 characters. Spaces
are allowed. Two partners cannot have the same Partner
Name. You cannot modify the Partner Name after the partner
is created.

Partner Code The Partner Code field is optional. If not specified, a Partner
Code is generated based on the Partner Name, up to the first
24 alphanumeric characters, when the partner is created.

A maximum of 24 alphanumeric characters. Only characters
from the US-ASCII alphabet, numbers, and special characters
of underscore, dash and period are permitted. Two partners
cannot have the same Partner Code. You cannot modify the
Partner Code after the partner is created.
Note: If you specify a Partner Code different from the
Partner Name, do not specify ProducerCode or
ConsumerCode in the root portion of the mailbox path when
you create a routing channel. A mailbox would be created
that cannot be accessed by users to download files.

A consumer mailbox path pattern of /${ConsumerName}/
from_${ProducerCode} or a producer mailbox path of
/${ProducerName}/to_${ConsumerCode} is valid.

Address Address of the Partner. Optional.

City City of the Partner. Optional.

State State or province the Partner operates in. Optional.

Zip or Postal Code Postal code for the Partner. Optional.

Telephone Number Phone contact number for the Partner. Required.

Country Select from the list. Required. Default is UNITED STATES.

Time Zone Select from the list. Required. Default is (GMT-05:00) Eastern
Time (US & Canada).

Email Address Email address of the Partner. Required.

5. Complete the steps in the wizard to create a user account:

Field Description

Authentication
Type

Valid values are:

v Local

v External - authenticated outside Sterling File Gateway

For External Authentication Type, select the server that will perform
authentication in the Authentication Host field.

User Name A minimum of 5 characters and maximum of 36 characters. No
spaces, tabs, or the following characters:

!@#%^*()+?,<>[]{}\/"'|;

Password A maximum number of 100 characters. Must comply with rules in the
selected password policy, if one is specified. Disabled if
Authentication Type is External.

Password Policy Populated with values of password policy from Sterling B2B
Integrator. Default is blank (none). Disabled if Authentication Type is
External.
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Field Description

Authentication
Host

Populated with values from the customer_overrides.properties file. If
you are using IBM Sterling Secure Proxy for authentication, the
settings in Sterling Secure Proxy override the entry here. Disabled if
Authentication Type is Local.

Session Timeout (in
minutes)

Number of minutes of inactivity before session ends. Default is 15. To
change the default, System Administrators can edit
customer_overrides.properties to set

filegateway_ui.fgOnboardingDefaultSessionTimeoutInMinutes
= <new value>

Given Name A maximum number of 64 characters.

Surname A maximum number of 64 characters.

6. Specify the partner role:

Field Description

Partner is a Consumer of
Data

Select if the partner receives data from the Router. Then
select one of the following:

v Partner will initiate the connection to consume data.

v Partner will listen for a connection to consume data.

– Listen for FTP Connections

– Listen for Connect:Direct Connections

– Listen for SSH/SFTP Connections

– Listen for WebSphere MQ FTE Connections

– Listen for FTPS Connections

– (Any custom protocols that have been added by the
administrator)

A partner can be either an initiating consumer or a listening
consumer, not both

54 Sterling File Gateway:



Field Description

If you selected: Partner will
listen for a connection to
consume data. > Listen for
FTP Connections

Specify the following fields:

v FTP Server Host Name (or IP address) (Required)

v FTP Listen Port. Default is 21. (Required)

v Connection Type - Active or Passive. Default is Active.
(Required)

v User Name (Required)

v Password (Required)

v Confirm Password (Required)

v Base Directory (Optional) Directory for the data to be
transferred to. Optional. Default is home directory after
login.

v Local Port Range (Optional) Any valid port numbers not
being used by another application running on the system.
Contact your network administrator if the port numbers
are restricted in any way. A port in the specified range
using the form <min-port>-<max-port> will be used to
establish a control channel to the remote FTP server. For
example, 50100-50200.

v Local Control Port Range (Optional) Any valid port
numbers not being used by another application running
on the system. A port in the specified range using the
form <min-port>-<max-port> will be used to establish a
control channel to the remote FTP server. For example,
50100-50200.

v Number of retries. Default is 3. (Required)

v Interval between retries (in minutes). Default is 1.
(Required)

v Upload file under a temporary name first? Yes or No.
Default is No. (Required)
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Field Description

If you selected: Partner will
listen for a connection to
consume data. > Listen for
Connect:Direct Connections

Values in [] are the associated Connect:Direct Server Begin
Session or Connect:Direct Copy To services parameters.
Specify the following fields:

v Local Node Name (Required) [LocalCDNodeName]
Specifies the name of the local Connect: Direct Server
Adapter. List includes all configurations of the
Connect:Direct Server Adapter. Required.

v Remote Node Name (Required) [RemoteCDNodeName]
Specifies the name of a remote Sterling Connect:Direct
server node. This name must be same as the name of one
of the nodes in the netmap of the adapter identified by
LocalCDNodeName. Required.

v Local User Id (Optional) [LocalUserId] Overrides the
PNodeId (the user executing the BP). Optional.

v Remote User Id (Optional) [RemoteUserId] Specifies the
UserId to be used on remote Sterling Connect:Direct
server node. Required except when:

1. Remote password not provided in the invoked BP.

2. Remote Sterling Connect:Direct server is configured to
accept an inbound connection from a designated
PNodeName (Specified Connect:Direct Server Adapter
name in the invoked BP) and PNodeId (the user
executing the BP). If you specify the LocalUserId, it is
used in place of PNodeId.

v Remote Password (Optional) [RemotePasswd] Specifies
the password to be used on remote Sterling
Connect:Direct server node. Optional.

v Remote Password Confirm (Optional)

v Remote File Name (Optional) [RemoteFileName] Name
that should be given to the destination file that is copied
to the remote Sterling Connect:Direct server. Required.

v Disposition to be applied to remote file (Optional)
[RemoteDISP] Specifies how the destination file is to be
created on the remote Sterling Connect:Direct server.
Optional.

v Sysopts string to be applied to remote file (Optional)
Sysopts syntax varies by platform and you must use the
syntax for the platform that is performing the work. See
the IBM Sterling Connect:Direct Process Language Reference
Guide for more information.

v CheckpointInterval to be used for checkpoint restart
(Optional) Specifies the byte interval for checkpoint
support, which allows restart of interrupted transmissions
at the last valid checkpoint point and therefore reduces
the time to retransmit the file. Optional. Valid value is
number of bytes, in one of the following formats:

– nnnnnnnnnn

– nK or nM

– nm or nk

The values supplied for the preceding fields are passed to
Sterling Connect:Direct.
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Field Description

If you selected: Partner will
listen for a connection to
consume data > Listen for
SSH/SFTP Connections

Select an SSH Remote Profile on the next page.
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Field Description

If you selected Partner will
listen for a connection to
consume data > Listen for
WebSphere MQ FTE
Connections

For more information on each of the parameters below,
please see the IBM WebSphere MQ File Transfer Edition
Documentation and search for the equivalent WebSphere
MQ File Transfer Edition term that is provided. Values in []
are the associated WebSphere MQ File Transfer Edition
Create Transfer service parameters. Specify the following
fields:

v Source Agent Adapter [SourceAgentAdapter] - Name of
the WebSphere MQ File Transfer Edition Agent Adapter
in Sterling B2B Integrator that will act as the source agent
in deliveries to this partner. Drop-down list. (Required)

v Destination Agent Name [DestAgentName] - Name of
destination agent where deliveries to this partner will be
sent.

v Destination Agent Queue Manager [DestAgentQMgr] -
Name of destination agent's queue manager.

v Destination Type [DestType] - Defines if delivered file is
created as a file, data set or file space object on the
destination agent. Valid values are:

– file

– partitioned data set

– sequential data set

– file space

Required.

v Destination Directory, Data Set or File Space (Required)
[DestName] - When Destination Type is ‘file’ this field
defines the directory on the destination where the file will
be transferred. The file name is determined by the File
Gateway Routing Channel Template configuration used
for the route. When Destination Type is 'file space', this
field defines the user file space on the destination agent
where the file will be transferred. The file name is
determined by the File Gateway Routing Channel
Template configuration used for the route. When
Destination Type is 'partitioned data set' or 'sequential
data set', this field contains the data set specification.
Additionally, the first occurrence of the string ${FileName}
will be replaced by the file name determined by the File
Gateway Routing Channel Template configuration used
for the route.

v Destination File Already Exists (Required).
[DestFileBehavior] Disposition when a file of the same
name already exists at the destination. Valid values are:

– error (default)

– overwrite

v Queue For Transfer Status Reply Messages (Required)
[ReplyQueueName] - Name of the queue where reply
messages will be placed.

v Queue Manager Containing Reply Queue (Required)
[ReplyQMgr] - Name of the queue manager for the reply
queue.

v Priority [Priority] - Priority of transfer as integer Valid
values are:

– 0 (default)

– 1

– 2

– 3

– 4

– 5

– 6

– 7

– 8

– 9 (high)

Required.
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Field Description

v Transfer Mode [TransferMode] - Valid values are:

– binary (no conversion) (default)

– text (automatic conversion)

Required.

v Checksum Method - Type of checksum calculated on file
to ensure integrity of transfer. Valid values are:

– MD5 (default)

– None

Required.

v User Defined Metadata Name [MetaData] - Value pairs of
metadata values as comma separated list
(name1=value1,name2=value2). Optional.

v User Defined Job Name [JobName] - Job name associated
with transfer request. Optional.

If you want to run commands on the non-Sterling B2B
Integrator destination, specify:

v Pre-Transfer Command Type [PreDestCommandType].
Valid values are:

– NONE (default) If set to NONE then no command will
be run and other Pre-Destination parameters will be
ignored.

– EXECUTABLE

– ANTSCRIPT

– JCL

v Pre-Transfer Command [PreDestCommand] - Name of
command, antscript or JCL job to be run on destination
agent before transfer starts.

v Pre-Transfer Executable Arguments [PreDestArguments] -
Arguments passed to command when type is
EXECUTABLE. Format is a comma separated list of
arguments. Within the list, the first occurrence of the
string ${FileName} will be replaced with the delivery file
name generated by the routing channel.

v Pre-Transfer Ant Properties [PreDestProperties] -
Properties passed to ant when type is ANTSCRIPT.
Comma separated list of name value pairs:
name1=value,name2=value2. Within the list, the first
occurrence of the string ${FileName} will be replaced with
the delivery file name generated by the routing channel.

v Pre-Transfer Ant Targets [PreDestTargets] - Name of
targets to be run when type is ANTSCRIPT. Comma
separated list of targets: target1,target2

v Pre-Transfer Retry Count [PreDestRetryCount] - The
maximum number of retries that the agent permits.

v Pre-Transfer Retry Wait [PreDestRetryWait] - The
maximum wait, in seconds, between retries that the agent
permits.

v Pre-Transfer Successful Return Code [PreDestSuccessRC] -
Specifies the return code that indicate the program
invocation ran successfully.

v Post-Transfer Command Type [PostDestCommandType].
Valid values are:

– NONE (default) If set to NONE then no command will
be run and other Post-Destination parameters will be
ignored.

– EXECUTABLE

– ANTSCRIPT

– JCL

v Post-Transfer Command [PostDestCommand]- Name of
command, antscript or JCL job to be run on destination
agent after transfer completes.

Version 2.2.3 Updates 59



Field Description

v Post-Transfer Executable Arguments [PostDestArguments]
- Arguments passed to command when type is
EXECUTABLE. Format is a comma separated list of
arguments. Within the list, the first occurrence of the
string ${FileName} will be replaced with the delivery file
name generated by the routing channel.

v Post-Transfer Ant Properties [PostDestProperties] -
Properties passed to ant when type is ANTSCRIPT.
Comma separated list of name value pairs:
name1=value,name2=value2. Within the list, the first
occurrence of the string ${FileName} will be replaced with
the delivery file name generated by the routing channel.

v Post-Transfer Ant Targets [PostDestTargets] - Name of
targets to be run when type is ANTSCRIPT. Comma
separated list of targets: target1,target2

v Post-Transfer Retry Count [PostDestRetryCount] - The
maximum number of retries that the agent permits.

v Post-Transfer Retry Wait [PostDestRetryWait] - The
maximum wait, in seconds, between retries that the agent
permits.

v Post-Transfer Successful Return Code [PostDestSuccessRC]
- Specifies the return code that indicate the program
invocation ran successfully.

If you selected: Partner will
listen for a connection to
consume data. > Listen for
FTPS Connections

Specify the following fields:

v FTP Server Host Name (or IP address) (Required)

v FTP Listen Port. Default is 21. (Required)

v Connection Type - Active or Passive. Default is Active.
(Required)

v User Name (Required) ⌂Password (Required)

v Confirm Password (Required)

v Base Directory (Optional) Directory for the data to be
transferred to. Optional. Default is home directory after
login.

v Local Port Range (Optional) Any valid port numbers not
being used by another application running on the system.
Contact your network administrator if the port numbers
are restricted in any way. A port in the specified range
using the form <min-port>-<max-port> will be used to
establish a control channel to the remote FTP server. For
example, 50100-50200.

v Local Control Port Range (Optional) Any valid port
numbers not being used by another application running
on the system. A port in the specified range using the
form <min-port>-<max-port> will be used to establish a
control channel to the remote FTP server. For example,
50100-50200.

v Number of retries. Default is 3. (Required)

v Interval between retries (in minutes). Default is 1.
(Required)

v Upload file under a temporary name first? Yes or No.
Default is No. (Required)
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Field Description

If you selected: Partner will
listen for a connection to
consume data. > (Any
custom protocols that have
been added by the System
Administrator)

Additional fields may be available on the following page,
according to the definitions by the System Administrator.

Partner is a Producer of Data Select if this partner initiates protocol connections and
produces data. A partner can be both a consumer and a
producer of data.

7. Answer "Will Partner use either SSH/SFTP or SSH/SCP protocol to initiate
connections?" Select Yes or No. Default is No. If Yes, you can specify if
Partner will use an Authorized User Key to authenticate.
On the SSH Authorized User Key page, assign a public key by clicking the
arrows to a move key from the Available pane to the Assigned pane. Click
Next. Optional.

Note:

To assign multiple Authorized User Keys to a partner, the system
administrator can go to Tools > B2B Console > User Accounts, edit the user
and supply multiple keys. However, any subsequent edit of that user in the
Sterling File Gateway partner wizard will override those changes and replace
the multiple Authorized User Keys with the single Authorized User Key seen
in the Sterling File Gateway user interface.

If multiple Authorized User Keys are configured (from B2B Console), only one
of them will be selected within the AFT edit screen. It will be selected based
on database ordering.

8. Answer "Will Partner use an Authorized User Key to authenticate?" Select Yes
or No. Default is No. If Yes, you must provide the Authorized User Key.

9. Confirm the Partner information and save.
10. Close the Communities window, but do not log out.
11. On the Partner page, click Refresh below the Partners list. The new Partner is

listed.
For each partner, one user account is automatically created and associated
with the default user group. For additional users, create the user account in
Sterling B2B Integrator, then associate it with the partner identity and the
appropriate user group.
By default. Partners are automatically associated with the File Gateway All
Partners partner group.

Operator help

Searching for a File
The Basic Search page enables you to search for a file based on criteria you select.
The Advanced Search page provides more options for criteria.

About this task

You can specify more criteria to narrow your results, or fewer criteria to widen
your results. For any field, leave blank to select all values.
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Procedure
1. On the Search Criteria tab, enter the basic search criteria. This page is useful

for finding files in major categories. To search for more-specific files, select
Advanced Search. All of the criteria on the Basic Search page are also
available on the Advanced Search page, along with many more criteria.

2. For Producer, select from the list or type the producer name. Leave this field
blank to search for files from all producers.

3. For Consumer, select from the list or type the consumer name. Leave this
field blank to search for files from all consumers.

4. For Status, select one or more from:
v Started - includes Started, Determining Routes, Pending, and Routing
v Succeeded - includes Routed (arrived files, routes and deliveries)
v Failed - includes Failed
v Ignored - includes Ignored
Leave blank to search for files with any status.

5. For Protocol used by the producer to submit the message, select from:
v FTP
v SFTP
v Connect:Direct
v WMQFTE
Leave blank to search for files using any protocol.

6. For Original File Name, type the full or partial name of the file the producer
sent. This field is case-insensitive. File names containing the string will be
matched in the search. Leave this field blank to search for all file names.

7. Click Find to initiate the search. The Search Results tab opens and the Arrived
File pane is displayed with results matching all of your criteria. A maximum
of 1000 files (or another limit set by your System Administrator) is displayed.
The following information is provided for each arrived file:
v Reviewed
v Status
v Producer
v Original File Name
v Discovery Time

8. If more than 1000 files (or another limit set by your System Administrator)
match your criteria, a message is displayed indicating that you have more
than 1000 matches and need to narrow your search. The first 1000 files are
displayed.

9. Sort the results by clicking on any column header. Click again to change from
descending order to ascending order. The default sort is by Discovery Time,
in descending order.

10. To search for a file with more specific criteria, click on Advanced Search.
11. Select criteria in the Arrived File section from the following fields:

Field Description

Producer The partner who creates and sends files.
Select from the list. Type the producer name
to obtain unpurged data for producers who
have been deleted. Leave blank to search for
files from all producers.
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Field Description

Producer Code The code for the producer. Select from the
list. Type the producer code to obtain
unpurged data for producers who have been
deleted. Leave blank to search for files from
all producers.

Producer Group The group the producer is a member of.
Select from the list. Type the producer group
to obtain unpurged data for groups that
have been deleted. Leave blank to search for
files from all groups.

IP Address If the protocol is EBIC, FTP or SFTP, the host
IP address of the producer. For WebSphere
MQ File Transfer Edition, the Agent Name.
For Sterling Connect:Direct, the Node Name.

User User ID of the protocol authentication. For
WebSphere MQ File Transfer Edition, this is
the MQMD User Id associated with the
transfer.

Protocol Select from:

v FTP

v SFTP

v Connect:Direct

v WMQFTE

Original File Name Full or partial name of the file the producer
sent. This field is case-insensitive.

File Size (Min) (kilobytes) Smallest file size to search for.

File Size (Max) (kilobytes) Largest file size to search for.

Status Select one or more from:

v Started - includes Started, Determining
Routes, Pending, and Routing

v Succeeded - includes Routed (arrived files,
routes and deliveries)

v Failed - includes Failed

v Ignored - includes Ignored

This is the status of the Arrived File.

Reviewed Select to:

v Show both reviewed and unreviewed
arrived files.

v Show only unreviewed arrived files.

v Show only reviewed arrived files.

Note: Use these options to manage your
review process of file transfers.

Message ID The numeric message ID of the arrived file.

Mailbox Path Full or partial name for the mailbox
directory path of the arrived file. This field
is case-insensitive.

Dataflow ID The numeric dataflow ID for the file.

Date (From) Click on the calendar icon to select the date
to begin the search.
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Field Description

Date (To) Click on the calendar icon to select the date
to end the search.

Time (From) The arrival hour, in 24-hour format, to begin
the search. If the date fields are left blank,
the time fields are ignored. If 0 is entered,
records for all times are returned.

Time (To) The arrival hour, in 24-hour format, to end
the search. If the date fields are left blank,
the time fields are ignored. If 0 is entered,
records for all times are returned.

12. Select criteria in the Route section from the following fields:

Field Description

Consumer The partner who receives files directly or in
a mailbox. Select from the list. Type the
consumer name to obtain unpurged data for
consumers who have been deleted. Leave
blank to search for files from all consumers.

Consumer Code The code for the consumer. Select from the
list. Type the consumer code to obtain
unpurged data for consumers who have
been deleted. Leave blank to search for files
from all consumers.

Consumer Group The group the consumer is a member of.
Select from the list. Type the consumer
group to obtain unpurged data for groups
that have been deleted. Leave blank to
search for files from all groups.

Template Name Routing Channel Template applied to the
file transfer.
Note: Finds files that successfully routed
based on the template.

Facts Select from:

v ConsumerCode

v ConsumerFilename

v ConsumerName

v ConsumerPgpExtension

v ProducerCode

v ProducerFilename

v ProducerName

Note: The list will also include any custom
facts defined by the Integration Architect,
with a prefix of "my".

Fact Value Value for the fact selected above. Required
when Fact is selected. This field is
case-insensitive.
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Field Description

Status Select one or more from:

v Started - includes Started, Determining
Routes, Pending, and Routing

v Succeeded - includes Routed (arrived files,
routes and deliveries)

v Failed - includes Failed

This is the status of the Route.

13. Select criteria in the Delivery section from the following fields:

Field Description

IP Address If the protocol is EBIC, FTP or SFTP, the host
IP address for the delivered file. For
WebSphere MQ File Transfer Edition, the
Agent Name. For Sterling Connect:Direct,
the Node Name. Host IP address for the
delivered file if the protocol is . Do not use
with In Mailbox specified as the protocol.

User User ID of the protocol authentication. Do
not use with In Mailbox specified as the
protocol.

Protocol Delivered file protocol. Select from:

v FTP

v Inbound FTP

v Outbound FTP

v SFTP

v Inbound SFTP

v Outbound SFTP

v Connect:Direct

v Inbound Connect:Direct

v Outbound Connect:Direct

v WMQFTE

v In Mailbox (for files that have not been
retrieved)

Delivered File Status Select one or more from:

v Started - includes Transforming,
Delivering, and Redelivery

v Succeeded - includes Complete

v Failed - includes Failed

This is the status of the delivered file.

Delivered File Name Full or partial name of the delivered file.
This field is case-insensitive.

File Size (Min) (kilobytes) Smallest file size to search for.

File Size (Max) (kilobytes) Largest file size to search for.

Message ID The numeric message ID of the delivered
file.
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Field Description

Mailbox Path Full or partial name for the mailbox
directory path of the delivered file. This field
is case-insensitive.

Date (From) Click on the calendar icon to select the date
to begin the search.

Date (To) Click on the calendar icon to select the date
to end the search.

Time (From) The delivery hour, in 24-hour format, to
begin the search. If the date fields are left
blank, the time fields are ignored. If 0 is
entered, records for all times are returned.

Time (To) The delivery hour, in 24-hour format, to end
the search. If the date fields are left blank,
the time fields are ignored. If 0 is entered,
records for all times are returned.

Note: Searches using the characters _ and % (underscore and percent) may
produce more results than expected, because these characters are interpreted
as wildcards. Specify more characters to narrow your search, or visually
search for the matches within the returned results.

Results

Search results

In the search results for arrived files, the Producer Name is listed, if available. If
Producer Name is not available, the Producer Code is listed in italics.

In the search results for routes, the Consumer Name is listed, if available. If
Consumer Name is not available, the Consumer Code is listed in italics.

Troubleshoot and Resolve Issues after a System Failure
After a system failure, producer messages which did not get deleted from the
producer mailbox need to be resolved.

About this task

Perform the following steps to resolve producer messages which did not get
deleted from the producer mailbox after a system failure. A system administrator
can resolve some cases without producer partner involvement, starting with step 1.
Otherwise, producer partners start at step 2.

Procedure
1. As system administrator, find out if the message got routed.

a. Select Tools > B2B Console.
b. Find the Message ID of the files from Deployment > Mailboxes >

Messages.
c. Search in Sterling File Gateway using advanced search by Message ID.
d. If you find a result for the Message ID, the message status should be Failed.

Replay the Arrived File. This enables you to resolve the issue without
producer partner involvement.
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e. If you did not find a result for the Message ID, contact the producer partner
and have the producer partner rename the file, with the instructions in Step
3.

2. As the producer partner, determine if the message got routed.
a. Log in to your producer mailbox and note of the name of the message.
b. In myFileGateway, search for activity by Original File Name.
c. If you find a result for the Original File Name, it should have a status of

Failed. Replay the arrived file.
d. If you did not find a result for the Original File Name, go to step 3 and

rename the file.
3. As the producer partner, rename the message. Renaming causes the message to

be routed.
a. Log in as the producer partner user that added the file to Sterling File

Gateway.
b. Navigate to the mailbox directory that contains your message.
c. Rename the message using the exact same file name. The rename command

varies for different protocols and clients. For example, the command line in
FTP and SFTP is the following:
rename filename filename

Determining status of files after a system failure
After a system failure of Sterling File Gateway, some files may not have been
routed, and you need to confirm the status.

About this task

When a failover occurs, files may be in the following status:
v Routed
v Failed
v Routing
v Determining Routes

The producer files may have been processed, but may or may not be in mailboxes.
To identify the status of files:

Procedure
1. Select Tools > B2B Console.
2. Select Business Processes > Monitor > Advanced Search > Business

Processes.
3. On the right side, under the section Search Using Business Processes, select

System Business Processes > FileGatewayMailboxRoute.
4. Select State > ALL.
5. Select Status > Error.
6. Select Start Date From and To for the time of interest and click Go.
7. The result is a list of the failed business processes. Click the ID of each failed

business process to obtain the details of the business process.
8. Navigate through the pages to get the details of the failed service.
9. Click the info link under the Instance Data column for the failed service to

obtain the instance data screen.
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10. In the instance data screen, the current message indicates the iteration number
in the MessageId list above it. Count the iteration number from the message
list. This is the Message Id which you will use to determine the file.

11. Select Deployment > Mailboxes > Messages and enter the Message Id value
obtained in the previous step and click Go.

12. This returns the message name (the file) associated with the Message Id. Call
the producer partner who sent this file and ask them to re-send the file.

Note: Ensure that all the messages which follow the failed message have been
correctly recovered. Check their status and recover as necessary.

filegateway_eventcodes.properties
The filegateway_eventcodes.properties file contains properties that control the
operation of event codes in Sterling File Gateway. The Name property has been
modified and a new property, DisplayName has been added to the file.

The property modifications and additions include:
v Name - This is the name of the event. Required. Example:

XX_0050.name=:MyCustomEventFailure
v DisplayName - Displayed in the subscription UI (Profile > Notifications).

Example: XX_0050.displayName=:My Custom Event Failure

Interpreting Delivery Status for WebSphere MQ File Transfer
Edition

Sterling File Gateway sends a message to WebSphere MQ File Transfer Edition,
and then some time later, WebSphere MQ File Transfer Edition sends a reply
message saying that the transfer is either complete or failed.

About this task

The file transfer occurs when the source and the destination agents are both
available, asynchronously from the request issued by Sterling File Gateway.

The delivery status is updated in Sterling File Gateway based on reply messages
received asynchronously from WebSphere MQ File Transfer Edition network.
During the time between Sterling File Gateway sending the message and the reply
from WebSphere MQ File Transfer Edition, the transfer status is:
v On the Arrived File tab - Routing
v On the Route tab - Delivering
v On the Delivery tab - Pending

See Manually changing delivery status if you have files that remain in Pending status
indefinitely.

Generating Reports
Several standard reports are defined in Sterling File Gateway.

Procedure
1. From the main menu, select Tools > Reports.
2. Select the information you would like the report to contain. Leave any field

blank to select all possible values. Options are:
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Field Description

Producer Select a producer for the arrived files to
report on. Do not use if Producer Group is
specified.

Producer Group Select a producer group for the arrived files
to report on. Do not use if Producer is
specified.

Consumer Select a consumer for the arrived files to
report on. Do not use if Consumer Group is
specified.

Consumer Group Select a consumer group for the arrived files
to report on. Do not use if Consumer is
specified.

Status Select one or more from:

v Started - includes Started, Determining
Delivery, and Delivering

v Succeeded - includes Complete

v Failed - includes Failed

v Ignored - includes Ignored

Date (From) Click on the calendar icon to select a starting
date.

Date (To) Click on the calendar icon to select an
ending date.

Time (From) Specify a time in the format hh:mm:ss.
Note: Query in server time. Report results
will be in server time, regardless of the
header label.

Time (To) Specify a time in the format hh:mm:ss.
Note: Query in server time. Report results
will be in server time, regardless of the
header label.

Group By Select from:

v Producer

v Consumer

Format Select from:

v HTML

v PDF

v XLS

Report Type Select from:

v Detailed - includes a Producer ID
(assigned by the system), Consumer,
Discovery Time, Completion Time, Status,
Original File Name, and File Size

v Summary - includes Total File Size and
Total Count by Success, Error, In Progress,
and Failure Reviewed

Note: Error count is the number in Failed
status that have not been reviewed.
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Field Description

Sort By Click and drag the following fields into the
desired order for sorting:

v Status

v File Name

v File Size

3. Select Generate Report.

Note: For reports with Asian characters, download and install the special
Acrobat Reader Asian font packs from www.adobe.com. Text for reports is
generated with iText using CJK fonts. If the Asian font packs are not installed,
Acrobat Reader may ask you to install when you open a PDF file containing
CJK fonts.
Depending on your selections, the report has the following contents:

Field Definition

Created On Date and time report was requested

Created By User ID that requested the report

Group By How the data is grouped

Report Config Selections made for report

Filters How the data is ordered

Producer ID ID assigned by the system for the producer
that created and sent the file

Consumer Partner that received the file. The Consumer
Name is listed, if available. If Consumer
Name is not available, the Consumer Code
is listed, delineated by <>.

Discovery Time Time file first entered system, in the server
time zone, regardless of the header label

Completion Time Time file transfer was completed, in the
server time zone, regardless of the header
label

Status Status when report was generated

Original File Name Name given to the file by the producer

File Size Size of the transferred file

Summary

v Producer

v Total File Size

v Total Count

v Success

v Error

v In Progress

v Failure Reviewed

For each producer, the total file size
transferred in the report period, total count
of files transferred in the report period, and
a count for each status category. The
Producer Name is listed, if available. If
Producer Name is not available, the
Producer Code is listed, delineated by <>.
Note: Error count is the number in Failed
status that have not been reviewed.

Note: By default, reports only include the first 1000 activity records that match
the specified criteria. Your System Administrator may set another value for the
number of records to be included in reports. (See System Administrator >
Install and Set Up > filegateway_ui.properties.)
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Note: Sterling File Gateway users with Microsoft Internet Explorer 7 may not
be able to open more than one PDF type report at a time due to Internet
Explorer 7 content blocking security. Close the original report window or adjust
Internet Explorer 7 browser setting or configure Adobe Reader to not open in a
browser (and instead open in an Adobe window).

In Internet Explorer 7, select Internet Options > Security (tab) > Custom level
> Downloads > Automatic prompting for file downloads > Enabled.

In Adobe Reader, select Preferences > Display PDF in browser > disabled.

Manually Changing Delivery Status
If files remain in Pending status indefinitely, you can manually change the delivery
status.

About this task

During the time between Sterling File Gateway sending the message and the reply
from WebSphere MQ File Transfer Edition, the transfer status is: "Pending." If there
are communication problems between Sterling File Gateway and WebSphere MQ
File Transfer Edition, files can remain in Pending status indefinitely. To resolve files
remaining in Pending status:

Procedure
1. On the Basic Search or Advanced Search page, select Started as the status.

Specify other criteria to narrow your results. For example, you may want to
specify transfers more than three days ago. Click Find.

2. Select a file in Routing status in the Arrived File list.
3. Click on the Delivery tab.
4. In the Status column, right click on Pending. Select:
v Mark as Complete
v Mark as Failed

Enter a comment (optional).

Restriction: You cannot redeliver a pending delivery.

Set the Language for Notifications Sent by email
With Sterling File Gateway 2.2.3 and above you can modify your Profile to receive
notifications in one of the supported languages listed in the About this task
section. When an event that you subscribe to occurs, the notification is sent to you
in the language of your choice. When you log in, the browser language setting and
the Profile language setting are compared. If they do not match you are prompted
to change the language for notifications.

About this task

The supported languages are:
v English
v German
v Simplified Chinese
v Traditional Chinese
v French
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v Spanish
v Italian
v Portuguese-Brazil
v Japanese
v Korean

Procedure
1. Select Profile from the main menu.
2. Select the notifications tab.
3. Select the language you want to use from the Language for notifications

drop-down list.
4. Select the Save Language button.

myFileGateway

Add Custom Tabs to myFileGateway
System Administrators can create new tabs for additional functionality in
myFileGateway. This sample is meant to serve as a starting point for the creation of
your own custom tabs. Please do not make your changes directly in the
<install>/samples directory, as these may be overwritten in a future patch. Instead,
you may maintain the WAR file in a directory entirely separate from the <install>
directory, as long as the HTTP Server Adapter is configured to find it.

About this task

With this change, every HTTP Server Adapter that hosts myfilegateway.war will
also have to host sampletab.war. In particular, visiting http://<host>:<baseport>/
myfilegateway will fail unless sampletab.war is copied to <install>/noapp/deploy.
If this condition hasn't been met, a request to /myfilegateway will fail to load the
login page. Use the browser to visit http://<host>:<baseport>/sampletab/
welcomepage.js and verify that the content of that file is shown.

One example of a custom tab you can add to myFileGateway is a Welcome Tab,
which is supplied as a sample in the install. When creating a custom permission
like the one in this example, make sure its "Permission Type" is "File Gateway".
You can use these assets, which ship with the sample, as the basis for your own
implementation:
v <install>/samples/filegateway/sample_myfg_tab/sampletab.war
v <install>/samples/filegateway/sample_myfg_tab/sampletab_imports.xml.in

This procedure describes how to create a new Welcome Tab in myFileGateway.

Procedure
1. Modify the <install>/properties/customer_overrides.properties and add this

line:
filegateway_ui.myfilegateway.extension_js_file_1=/sampletab/welcomepage.js

2. Create a permission named "Custom myFileGateway Sample Tab" with the ID
"CUSTOM_MYFG_WELCOME" and an HTTP Server Adapter instance named
"myFileGatewayWithSampleTab" by selecting Tools > B2B Console >
Deployment >Resources Manager >Import/Export and importing the file:

<install>/samples/filegateway/sample_myfg_tab/sampletab_imports.xml
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The password for the import file is "password" without the quotes. Import all
three assets within the import file.

3. Modify the HTTP Server Adapter Instance by selecting Tools > B2B Console >
Services Configuration and finding the HTTP Server Adapter that you created
in the previous step. Make these modifications:
a. On the first page, set the Group to None.
b. On the second page, change the port to one that doesn't conflict with any

other port on the instance.
c. Enable the adapter instance by clicking the "Enable Service for Business

Processes" box on the confirmation page.
4. Select Tools > B2B Console > Accounts > Groups and verify that the "File

Gateway Partner Users" group includes the permission named "Custom
myFileGateway Sample Tab". Custom permissions relating to the custom tabs
must be of the "File Gateway" type.

5. Restart the server:
a. <install_dir>/bin/hardstop.sh
b. <install_dir>/bin/run.sh

6. Login to myFileGateway using the port specified in Step 3 to verify that the new
tab named "Custom Welcome Page" is visible. The custom tab web application
may need to know the name of the user that is logged into myFileGateway. You
can determine this by retrieving the HTTP Session attributes
"dlssoAuthenticated" and "autho". If the visitor to the custom tab web
application authenticated to myFileGateway, the value of the
"dlssoAuthenticated" attribute will be the string "true" and the value of the
"autho" attribute will be the name of the logged in user as a string.

Searching for File Activity in myFileGateway
Search for file activity to view details about the events that occurred during
routing.

About this task

You can only view the activity of files you are the producer or consumer for. The
events you can view for the file depend on whether you are the producer or the
consumer, and will typically differ from the events that an administrative use can
view.

Procedure
1. On the Search Criteria tab, enter the basic search criteria.
2. For Producer, indicate if you want to search for activity related to files sent to

you by a specific producer.
3. For Consumer, indicate if you want to search for activity related to files you

sent to a specific consumer.
4. For Status, select one or more from Started (includes Pending), Succeeded,

Failed, or Ignored. Leave blank to search for routes with any status.
5. For Protocol, select from: FTP, SFTP, Connect:Direct, WMQFTE (WebSphere

MQ File Transfer Edition), EBICS. Leave this field blank to search for routes
using any protocol.

6. For Original File Name, type the full or a portion of the file name of the file
before processing. This is the name of the file when it entered Sterling File
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Gateway. This field is case-sensitive. Only those files containing the string you
enter will be matched in the search. Leave this field blank to search for all file
names.

7. Click Find to initiate the search. The Search Results tab opens and the
Arrived File pane is displayed with results matching all of your criteria. A
maximum of 1000 files is displayed. The following information is provided by
default for each arrived file:
v Status
v Producer Name, if available, or Producer Code, delineated by <>
v File Name
v Discovery Time
To see additional information about the arrived file, right-click on one of the
column headings to select the columns that are displayed. Options are:
Reviewed, ID, Status, Producer, Mailbox Path, Original File Name, Discovery
Time, and File Size.

8. If more than 1000 files match your criteria (or a different number set by your
system administrator), a message is displayed indicating that you have more
than 1000 matches and need to narrow your search.

9. Sort the results by clicking on any column header. Click the column header
again to change from descending order to ascending order. The default sort is
by discovery time, in descending order.

10. Right-click on a column and select fields to turn columns off or on to focus on
the details you are interested in.

Generating Reports in myFileGateway
Procedure
1. In myFileGateway, click on the Reports tab.
2. Select the information you would like the report to contain. Leave any field

blank to select all possible values. Options are:

Field Description

Producer Indicate if you were the producer on activity
to include in the report.

Consumer Indicate if you were the consumer on
activity to include in the report.

Status Select one or more from:

v Started - includes Determining Delivery
and Delivering

v Succeeded - includes Complete

v Failed - includes Failed

v Ignored - includes Ignored

Date (From) Click on the calendar icon to select a starting
date.

Date (To) Click on the calendar icon to select an
ending date.

Time (From) Specify a time in the format hh:mm:ss.
Note: Query in server time. Report results
will be in server time, regardless of the
header label.
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Field Description

Time (To) Specify a time in the format hh:mm:ss.
Note: Query in server time. Report results
will be in server time, regardless of the
header label.

Group By Select from:

v Producer

v Consumer

Format Select from:

v HTML

v PDF

v XLS

Report Type Select from:

v Detailed - includes a Producer ID
(assigned by the system), Consumer,
Discovery Time, Completion Time, Status,
Original File Name, and File Size

v Summary - includes Total File Size and
Total Count by Success, Error, In Progress,
and Failure Reviewed

Note: Error count is the number in Failed
status that have not been reviewed.

Sort By Select from:

v Status

v File Name

v File Size

3. Select Generate Report.

Note: For reports with Asian characters, download and install the special
Acrobat Reader Asian font packs from www.adobe.com. Text for reports is
generated with iText using CJK fonts. If the Asian font packs are not installed,
Acrobat Reader may ask you to install when you open a PDF file containing
CJK fonts.
Depending on your selections, the report has the following contents:

Field Definition

Created On Date and time report was requested

Created By User ID that requested the report

Group By How the data is grouped

Report Config Selections made for report

Filters How the data is ordered

Producer ID User ID that created and sent the file

Consumer Partner that received the file. The Consumer
Name is listed, if available. If Consumer
Name is not available, the Consumer Code
is listed, delineated by <>.

Discovery Time Time file first entered system, in the server
time zone, regardless of the header label
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Field Definition

Completion Time Time file transfer was completed, in the
server time zone, regardless of the header
label

Status Status when report was generated

Original File Name Name given to the file by the producer

File Size Size of the transferred file

Summary

v Producer

v Total File Size

v Total Count

v Success

v Error

v In Progress

v Failure Reviewed

For each producer, the total file size
transferred in the report period, total count
of files transferred in the report period, and
a count for each status category. The
Producer Name is listed, if available. If
Producer Name is not available, the
Producer Code is listed, delineated by <>.
Note: Error count is the number in Failed
status that have not been reviewed.

Note: By default, reports only include the first 1000 activity records that match
the specified criteria. Your System Administrator may set another value for the
number of records to be included in reports.

Set myFilegateway Language Notifications
With Sterling File Gateway 2.2.3 and above you can modify your Profile to receive
notifications in one of the supported languages listed in the About this task
section. When an event that you subscribe to occurs, the notification is sent to you
in the language of your choice. When you log in, the browser language setting and
the Profile language setting are compared. If they do not match you are prompted
to change the language for notifications.

About this task

The supported languages are:
v English
v German
v Simplified Chinese
v Traditional Chinese
v French
v Spanish
v Italian
v Portuguese-Brazil
v Japanese
v Korean

Procedure
1. Select Profile from the main menu.
2. Select the notifications tab.
3. Select the language you want to use from the Language for notifications

drop-down list.
4. Select the Save Language button.
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Notices

This information was developed for products and services offered in the US. This
material might be available from IBM in other languages. However, you may be
required to own a copy of the product or product version in that language in order
to access it.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of
express or implied warranties in certain transactions, therefore, this statement may
not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
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websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

The performance data and client examples cited are presented for illustrative
purposes only. Actual performance results may vary depending on specific
configurations and operating conditions.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBMproducts.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

Statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to actual people or business enterprises is entirely
coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
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IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work must
include a copyright notice as shown in the next column.

© 2015.
Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2015.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the web at "Copyright and
trademark information" at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.
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Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following
terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM
website.

Personal use

You may reproduce these publications for your personal, noncommercial use
provided that all proprietary notices are preserved. You may not distribute, display
or make derivative work of these publications, or any portion thereof, without the
express consent of IBM.

Commercial use

You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make
derivative works of these publications, or reproduce, distribute or display these
publications or any portion thereof outside your enterprise, without the express
consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or
rights are granted, either express or implied, to the publications or any
information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as
determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United States
export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.
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